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1 Document information

1.1 Target audience for this manual
This manual should support during the configuration of Tankvision Professional NXA85.
Beside basic PC operating knowledge no special training is needed to perform the Tank 
Gauging System operations. Nevertheless it is recommended receiving a training on the 
system by Endress+Hauser.

1.2 Version history

Due to the certification process with weights and measures agencies, some of the 
functionality might not be present in the software version 18.0.3.

1.3 Document function

1.3.1 Used symbols

Safety symbols

Electrical symbols 

Document version Valid for SW version Changes to the previous version

BA00390G/00/EN/13.10 18.0.0 Initial version

BA00390G/00/EN/14.15 18.0.2 and 18.0.3                                     New layout; Enhanced Product, Tank 
and Movement functionality

Symbol Meaning

A0011189-EN

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will 
result in serious or fatal injury.

A0011190-EN

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in serious or fatal injury.

A0011191-EN

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in minor or medium injury.

A0011192-EN

NOTICE!
This symbol contains information on procedures and other facts which do not result 
in personal injury.

Symbol Meaning

A0011197

Direct current
A terminal to which DC voltage is applied or through which direct current flows.

A0011198

Alternating current
A terminal to which alternating voltage is applied or through which alternating current flows.

A0011200

Ground connection
A grounded terminal which, as far as the operator is concerned, is grounded via a grounding 
system.

DANGER

WARNING

CAUTION

NOTICE

)
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Symbols for certain types of information

Symbols in graphics

1.4 Documentation

1.4.1 Operating instructions

A0011199

Protective ground connection
A terminal which must be connected to ground prior to establishing any other connections.

Symbol Meaning

A0011193

Tip
Indicates additional information.

A0011195

Reference to page
Refers to the corresponding page number.

 ,  ,  ... Series of steps

A0018373

Result of a sequence of actions

Symbol Meaning

1, 2, 3 ... Item numbers

 ,  ,  ... Series of steps

A, B, C ... Views

A0011187

Hazardous area
Indicates a hazardous area.

A0011188

Indicates a non-hazardous location
Safe area (non-hazardous area)

Document number Instrument Type of Document

BA00390G/00 Tankvision Professional System Configuration

BA00391G/00 Tankvision Professional Data Communications Controller

BA00392G/00 Tankvision Professional Installation

BA00393G/00 Tankvision Professional Maintenance

BA00394G/00 Tankvision Professional Movements System Configuration

BA00395G/00 Tankvision Professional Movements Operation

BA00396G/00 Tankvision Professional System Operation

BA01293G/00 Tankvision Professional OPC Tank Data Server

BA01294G/00 Tankvision Professional OPC TG Client Configuration

BA01295G/00 Tankvision Professional Web Server/Client System Operation

BA01363G/00 Tankvision Professional Product and Tank Data Synchronisation

*

1. 2. 3.

1. 2. 3.

-

.
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2 Identification

2.1 Product identification
The following options are available for identification of the software:

• Nameplate specifications
• Order code with breakdown of the software features on the delivery note
• Enter serial numbers from nameplates in W@M Device Viewer

(www.endress.com/deviceviewer): All information about the software is displayed.

For an overview of the technical documentation provided, enter the serial number from the 
nameplates in the W@M Device Viewer (www.endress.com/deviceviewer)

2.2 Nameplate

nameplate

1 Address of manufacturer
2 Device name 
3 Order code 
4 Extended order code (Ext. ord. cd.) 
5 Serial number (Ser. no.) 
6 Certificate and approval relevant data
7 Barcode
8 CE mark

250002972--

Order code:

Ext. Order code:

Ser.-No.:

Tankvision

1 2 3 4 5

6

7

8
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2.3 Order code and device version
To find out the version of your software, enter the order code indicated on the 
nameplate in the search screen at the following address: www.products.endress.com/
order-ident

2.4 Device documentation
The information required to retrieve the documentation can be found on the nameplate of 
the device.

Technical documentation can also be downloaded from the Download Area of the 
Endress+Hauser web site: www.endress.com→ Download. However this technical 
documentation applies to a particular instrument family and is not assigned to a 
specific device.

2.4.1 W@M Device Viewer
Launch the W@M Device Viewer: www.endress.com/deviceviewer

Enter the serial number (Ser. no.) of the device: see nameplate.
 All the associated documentation is displayed.

2.4.2 Endress+Hauser Operations App
The Endress+Hauser Operations App is available both for android smart phones 
(Google Play Store) and for iPhones and iPads (App Store).

Via the serial number:

Launch the Endress+Hauser Operations App.

Enter the serial number (Ser. no.) of the device: see nameplate.
 All the associated documentation is displayed.

2.5 Registered trademarks
Microsoft®, Windows® and Internet Explorer® 

Registered trademarks of the Microsoft Corporation

Modbus®

Registered trademark of the Modbus-IDA, Hopkinton, MA, USA

Java®

Registered trademark of Sun Microsystems, Inc.

Mozilla® Firefox®

Registered trademark of the Mozilla Foundation

Android® and Google Play® are registered trademarks of Google Inc.

iPhone® and iPad® are trademarks of Apple® Inc., registered in the U.S. and other countries.

1.

2.

1.

2.
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3 Basic safety instructions

3.1 Requirements for the personnel
The personnel for installation, commissioning, diagnostics and maintenance must fulfill the 
following requirements: 

• Trained, qualified specialists: must have a relevant qualification for this specific function 
and task

• Are authorized by the plant owner/operator
• Are familiar with federal/national regulations
• Before beginning work, the specialist staff must have read and understood the instructions 

in the Operating Instructions and supplementary documentation as well as in the 
certificates
(depending on the application)

• Following instructions and basic conditions

The operating personnel must fulfill the following requirements:

• Being instructed and authorized according to the requirements of the task by the facility's 
owner operator

• Following the instructions in these Operating Instructions

3.2 IT security
We only provide a warranty if the device is installed and used as described in the Operating 
Instructions. The device is equipped with security mechanisms to protect it against any 
inadvertent changes to the device settings.

IT security measures in line with operators' security standards and designed to provide 
additional protection for the device and device data transfer must be implemented by the 
operators themselves.

3.3 Designated use

3.3.1 Application
Tankvision Professional is specifically designed for operators of bulk storage facilities, 
marketing terminals, refineries and pipelines. It is designed to handle all the data 
acquisition, supervisory control and monitoring required in a single fully integrated solution.

Tankvision Professional integrates all major types of tank measurement instruments into 
one system.

All measured and calculated tank parameters are accessible to your tank farm and terminal 
operators as well as to connected host systems.
Multi-user operation is provided by the inbuilt Web Server offering the opportunity to access 
data at any connected location (local/remote) e.g. for administrative and accounting 
purposes.

3.4 Workplace safety
For work on and with the device: 

• Wear the required personal protective equipment according to federal/national 
regulations.

• Switch off the supply voltage before connecting the device.
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3.5 Operational safety
Risk of injury!

• Operate the device in proper technical condition and fail-safe condition only.
• The operator is responsible for interference-free operation of the device.

Conversions to the device
Unauthorized modifications to the device are not permitted and can lead to unforeseeable 
dangers

• If, despite this, modifications are required, consult with Endress+Hauser.

Repair
To ensure continued operational safety and reliability,

• Carry out repairs on the device only if they are expressly permitted.
• Observe federal/national regulations pertaining to repair of an electrical device.
• Use original spare parts and accessories from Endress+Hauser only.

3.6 Product safety
The device is designed to meet state-of-the-art safety requirements, has been tested and left 
thefactory in a condition in which it is safe to operate. The device complies with the 
applicable standards and regulations as listed in the EC declaration of conformity and thus 
complies with the statutory requirements of the EG directives. Endress+Hauser confirms the 
successful testing of the device by affixing to it the CE mark.
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4 System Configuration
The System is provided with a suite of configuration tools allowing the user to create and 
configure their own database to reflect their own site configuration.
It is however recommended that any user wishing to configure a complete system attends a 
recognised training course at an approved support centre.
This manual assumes that the system software has been correctly installed in accordance 
with the Installation manual and any other release notes and instructions provided by the 
manufacturer of the software.
In order to successfully configure a system the following information will be required as a 
minimum:

• Tank details such as:
– Tank Identity
– Tank Shape
– Tank Operating Parameters
– Alarm set-points
– Calibration Table
– Product Name

• Gauge details such as:
– Gauge Type
– Gauge Address
– Data Items supported
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5 Tank Capacity Data Configuration

5.1 Tank Capacity Data Configuration Introduction
Tank capacity tables are required if the system is to calculate inventory data.
Each capacity table needs to be provided in a comma separated variable text file.

The accuracy of the volumes calculated by the system is only as good as the accuracy of 
the tank capacity points provided.

The utmost care must be taken when selecting the capacity points to be used. Indeed where 
possible the original tank strap points should be entered to get the best accuracy.

The use of this feature can be controlled by the security system.

5.2 Loading the Tank Capacity Table Module
To load the Tank Capacity Table Module, proceed as follows:

Select Configuration → Tank Capacity Tables from the main menu.

The Tank Capacity Table module will be loaded as follows:

BA00390GEN_0250

The list of tables will be populated with all tank capacity tables currently configured.

Tank Capacity Tables are bound to tanks in the tank characteristics menu option.

•Selecting File → New from the menu will allow naming and editing of options and 
data to create a new tank capacity table.
•Selecting File → Import Points will cause the import points screen to be displayed for 
import of a CSV file. 

Clicking the Graph button opens a pop-up with the graph of the currently selected tank 
capacity table. Clicking on the pop-up closes it.

1.
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BA00390GEN_0251

5.3 Adding a New Tank Capacity Table
To add a new tank capacity table, proceed as follows:

Select the File menu followed by the New option.

BA00390GEN_0252

Enter the name in Table ID.

You need to indicate whether the table role is for standard, water or hydrostatic 
deformation.

Then select type from Innage, Ullage, Delta Innage, Delta Ullage or Polynomial.

1.

2.

3.



Tank Capacity Data Configuration Tankvision Professional NXA85 - System Configuration

14 Endress+Hauser

BA00390GEN_0253

Enter a valid From date in the format 01/04/2011 00:00 (invalid format is ignored).

Enter the reference height and shell capacity.

Finally enter or import the points (up to 60,000) for the tank and then select File → 
Save.

5.4 Importing a Tank Capacity Table
To import a tank capacity table, proceed as follows:

Select the Table menu followed by the Import Points option.
The following prompt opens. Confirm with Yes.

BA00390GEN_0004

You will be prompted to enter a choice of CSV, Excel or Database for the source and given 
an option to change the engineering units for level and volume.

4.

5.

6.

1.
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BA00390GEN_0005

BA00390GEN_0006

Select the file for the tank capacity table. Click the Open button to load the calibration 
data into the database.

Any problems loading the data will be reported to the user. You will notice that a simple 
chart is plotted showing the characteristic of the calibration data. This is a useful aid to spot 
any erroneous data.
The plotted characteristic should be almost linear for Vertical Cylindrical tanks. For spherical 
and horizontal cylindrical tanks the plotted chart should exhibit a non-linear characteristic.

5.5 Viewing Existing Tables
Select Configuration → Tank Capacity Tables from the main menu.
The Tank Capacity Table module will be loaded as follows:

2.

1.
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BA00390GEN_0250

Select a Capacity Table to view the points and data.

Tables which have been superseded using the valid from field for the date of the new table 
to commence can be seen in the history tab.

2.
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5.6 Editing Values in an Existing Table
To edit values in an existing capacity table, proceed as follows:

Select the table to be edited from the list.
If you have the necessary security access rights you will be able to edit the table of values.

Type in the new value and move off the row to save the changes locally to the table.

BA00390GEN_0254

To save the changes to the database click the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

5.6.1 Inserting an Extra Row
To insert an extra row, proceed as follows:

Select the row at which a record needs to be inserted by clicking with the left mouse 
button on the left hand side of the row.

Select the Insert option.
A new row will be inserted.

1.

2.

3.

1.

2.
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BA00390GEN_0255

Enter the data for the new row.

To save the changes to the database click the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

Adding is much the same as inserting but appends a row to the end.

5.6.2 Deleting Rows
To delete a row, proceed as follows:

Select the row at which a record needs to be inserted by clicking with the left mouse 
button on the left hand side of the row.

Select the Delete option.
The row will be deleted.

To save the changes to the database click the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

5.7 Validity of Data
The user is not allowed to enter points in the wrong order all subsequent levels and volumes 
must be larger than the previous one.

3.

4.

1.

2.

3.
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BA00390GEN_0010
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6 Density Table Configuration

6.1 Density Table Configuration Introduction
Density tables are required if the user has selected Density Table as a volume correction 
method.
The utmost care must be taken when selecting the density points to be used to get the best 
accuracy.
The use of this feature can be controlled by the security system.

6.2 Loading the Density Table Module
Select Configuration → Density Tables from the main menu.
The Density Table module will be loaded as follows:

BA00390GEN_0011

The list of tables will be populated with all density tables currently configured.

Density tables are bound to tanks in the tanks characteristics menu option.

•Selecting File → New from the menu will allow naming and editing of options and 
data to create a new tank density table.
•Selecting File → Import Points will cause the import points screen to be displayed for 
import of a CSV file. 

6.3 Adding a Density Table
Select the File menu followed by the New option.

1.

1.
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BA00390GEN_0012

Put the name in Table ID.

BA00390GEN_0013

Finally enter or import the points (up to 200) for the tank and then File → Save.

6.4 Importing a Density Table
Select the Table menu followed by the Import option.

BA00390GEN_0014

2.

3.

1.
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You will be prompted to enter CSV for the source and given an option to change the 
engineering units for temperature and density.

BA00390GEN_0015

BA00390GEN_0016

Click the OK button to load the data into the database.
Any problems loading the data will be reported to the user.

6.5 Viewing Existing Tables
Select Configuration → Density Tables from the main menu.
The Density Table module will be loaded as follows:

2.

1.
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BA00390GEN_0011

Select a Density Table to view the points and data.

6.6 Editing Values in an Existing Table
Select the table to be edited from the list.  If you have the necessary security access rights 
you will be able to edit the table of values.

Type in the new value and move off the row to save the changes locally to the table.
The row will be deleted.

To save the changes to the database click the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

6.6.1 Inserting an Extra Row 
Select the row at which a record needs to be inserted by clicking with the left mouse 
button on the left hand side of the row.

Select the Insert option.
A new row will be inserted.

BA00390GEN_0018

2.

1.

2.

3.

1.

2.
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Enter the data for the new row.

To save the changes to the database click the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

Adding is much the same as inserting but appends a row to the end.

6.7 Deleting Rows
Select the row at which a record needs to be inserted by clicking with the left mouse 
button on the left hand side of the row.

Select the Delete option.
The row will be deleted.

To save the changes to the database click the  button.

If the application is closed prior to saving the changes you will be prompted to save the 
changes.

6.8 Validity of Data
The user is not allowed to enter points that are out of the temperature or density range, 
values outside this range will be highlighted red.

3.

4.

1.

2.

3.
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7 Tank Characteristics
Tank Characteristics allows entry and/or editing of the main tank operating parameters and 
calculation configuration parameters.
A number of the data items are important to the tank inventory calculations and it is 
therefore essential that they are configured correctly.

Tank characteristics are divided into several sections:
• Tank Details
• Tank Capacity Tables
• Roof Details
• Tank Correction
• Miscellaneous
• VCF Settings
• Calculation Control Settings
• Input Control Settings

Some values are dependent on other settings. Indeed some fields are not visible or 
enabled until they are called for by the setting of another parameter.
The use of this feature can be controlled by the security system.

Some settings are specific to certain calculation methods, these are listed below:

Tank Details screen
• JIS (Japanese Industrial Standards) Calculation Method is enabled when a JIS Volume 

Correction Method and a floating roof tank shape are selected.
• Correction Volume and Calibration density are enabled when a JIS volume correction 

method is selected.
• Selecting GBT or GBT(Direct_Weight) implies that a Hydrostatic deformation Table is in 

use. Not applying such a table will result in the failure of calculated values.

VCF settings screen
• Enraf polynomial constants A and B require EnrafChem2Poly or EnrafChemPoly1 volume 

correction method. C, D and E are only available when EnrafChemPoly1 is selected.
• The label ‘Chemical Concentration’ changes to ‘Alcohol strength by volume’ or ‘Alcohol 

strength by mass’ depending on the type of chemical calculation selected.
– HMD, Nitric = Chemical Concentration
– OIML R22 STRxVOL: Alcohol strength by volume
– JIS K2250 STRxVOL: Alcohol strength by volume
– OIML R22 STRxMASS: Alcohol strength by mass
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7.1 Launching Tank Characteristics
Select the Tank Characteristics option from the Configuration menu.

BA00390GEN_0019

The following display is typical of what will be loaded.

BA00390GEN_0020

The tree view on the left contains the list of all tanks within the system.
Clicking on any tank in the list automatically expands that tanks details.

Expand the tanks tree view in the list and click on the required item.

1.

2.
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• Ok, Apply, and Cancel buttons are provided.

• Use the Forward and Back  buttons to move through the history of edited 
pages.

• The Import / Export  buttons provide a means to export data from one tank for 
backup purposes or to overwrite the settings of another tank.

• When the Export  button is clicked, the user is prompted for a path and filename for 
the exported data. The path defaults to the tank gauging default export directory. All data 
held in Tank Characteristics except the tank name and associated tank capacity tables are 
exported.

• To import  data, first select the tank to import the data to then click the import button. 
All data except the tank name and associated tank capacity tables will be overwritten. If 
an error occurs or the user cancels the operation, the previous data will be restored.
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7.2 Modifying Data Within Tank Characteristics
To modify data within the tank characteristics, proceed as follows:

Select the tank to be modified from the list.

The current details for the tank will be displayed.

Take note that if this is the first time Tank Characteristics has been loaded after 
installing the system it will be displaying default values. It is essential that default 
values are replaced with the correct operating values.

Select the field to be edited and enter/select the new data.

Each field is validated both during data entry and just before the data is saved to the 
database.
You can use the TAB key to move to the next data entry field.

Press the Apply button to save the changes to the database.
If you want to abandon the changes, press the Cancel key.

If you attempt to select another tank after making some changes but before they are 
saved to the database, the system will warn you that changes have been made and 
request confirmation of whether they need to be saved or cancelled.

To edit further tanks follow the same procedure.

To exit the module, either close the Window or press the Cancel button.

1.

2.

3.

4.

5.
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7.3 Data Item Definitions
The following sections provide definitions of each of the data fields within each section of 
the Tank Characteristics module.

7.3.1 Tank Details

BA00390GEN_0256

Tank Shape (the physical shape of the tank)
Four principle tank shapes are supported:
• VC - Vertical Cylinder
• VCFR - Vertical Cylinder with Floating Roof
• SP - Sphere
• HZ - Horizontal Cylinder

There are other similar tank shapes, however, most should fall into one of the above types. 
Vertical Cylinders that have internal floating blankets/decks should be configured as VCFR.

It is essential that the tank shape is entered correctly as this affects the inventory 
calculation algorithms.

Product
It specifies the pre-configured product to be stored in the selected tank.
Products can be configured to have certain pre-selected characteristics attached to them. 
Products with characteristics are identified by being prefixed with an asterisk and being 
presented in bold font such as the KERO product shown below.
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Selecting a product with characteristics will override and disable certain settings within Tank 
Characteristics – an alert message is displayed to warn the user of this.

BA00390GEN_0164

The values that will be overridden are those configured as product characteristics in the 
Product Configuration.

If a tank has previously had a product WITH characteristics applied to it and this is 
changed to a product WITHOUT characteristics then the restricted settings will be re-
enabled but their value will remain unchanged.

Volume Correction Method
The table is related to the product that will be stored in the tank. It defines the method and 
operating ranges for certain characteristics of the product.
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It is essential that the volume correction method is selected correctly as this affects the 
inventory calculation algorithms.

Method of Calculation
By selecting a suitable calculation method, the user can cause the Calculation Control 
settings and Input Control Settings to be preset to values which are the accepted (or defined) 
default for the relevant standards body or type. These settings are then locked. If the user 
wishes to change these locked values, the Method of Calculation must be reset to None. The 
table below shows which settings are affected.
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Industry standard Flag

IP • Enable tank shell correction
• Use IP calculation of TOV/GOV
• Include suspended sediment & water
• Combined sediment and water calculation
• VCF is normal

API • Roof weight specified in air
• Enable tank shell correction
• WCF uses main Table 56
• Use API calculation of TOV/GOV
• Include suspended sediment & water
• Separate sediment & water calculation
• Net values calculated from gross
• VCF is normal

GB/T • Roof weight specified in air
• Enable tank shell correction
• WCF uses main Table 56
• Use API calculation of TOV/GOV
• Include suspended sediment & water
• Separate sediment & water calculation
• Net values calculated from gross
• VCF is normal
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Certain calculation types rely on this setting.

• For example, Hydrostatic Deformation will only be included if the Method of Calculation 
has been set to GBT or GBT (Direct_Weight).

• In the case of JIS_MDP calculations’ setting the control flag ‘VCF is restricted’ forces the 
rounding of input data to use +/- 0.002 kg/l and +/-0.25 °C.

JIS Calculation Method
Specifies the handling of floating roof corrections within JIS calculations. This option is only 
available upon selection of a floating roof tank shape and a JIS volume correction method.

JIS • Roof weight specified in air
• Gauge reads reference density
• Use API calculation of TOV/GOV
• Disregard suspended sediment and water
• Combined sediment and water calculation
• Water density 1.0 kg/l for fresh water
• Net values calculated from gross
• Tank shell is not insulated
• VCF is normal

JIS-MPD • Roof weight specified in air
• Gauge reads reference density
• Use API calculation of TOV/GOV
• Disregard suspended sediment and water
• Combined sediment and water calculation
• Water density 1.0 kg/l for fresh water
• Net values calculated from gross
• Tank shell is not insulated
• VCF is normal

Industry standard Flag
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Vapour Calculation
Specifies the vapour correction calculations that will be performed as part of the inventory 
calculations. None means that no vapour correction will be performed.

Metering Temperature/Combustion Temperature
Is the specified temperature at which the amount of fuel to be burned is notionally 
determined for calorific calculations.

Maximum Operating Level (the defined maximum operating level of the tank)
The accuracy of this value is important as it is also used to determine the maximum 
operating volume and consequently the amount of Ullage Volume (Available Room) in the 
Tank.

Minimum Operating Level (the defined minimum operating level of the tank)
The accuracy of this value is important as it is also used to determine the minimum operating 
volume and consequently the amount of Usable Volume in the Tank.

Min & Max Operating Volume
Are read-only fields provided for your reference.
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Adjustment Volume
Is a fixed volumetric adjustment (either +ve or –ve) applied to the volume obtained from the 
Tank Capacity table. This accounts for any manifold or pipeline volume to be added or any 
deadwood to be removed.

Calibration Density
The density of the medium in a tank when that tank was calibrated. This setting is only used 
in JIS based calculations.

Configuration Complete
Determines when data exchange can be carried out using the data exchange service. See the 
Product and Tank Data Synchronization manual BA01363G.

7.3.2 Tank Capacity Tables
This section allows the user to choose the Tank Capacity Tables and Density tables to be 
bound to each tank.

BA00390GEN_0167

The user may bind any of four types of table to each tank: Product, Water, Hydrostatic 
Deformation and Density. The density table option is only available for tanks that are set to 
use a density table as the volume correction method.
Furthermore, each table type can be selected by either the Table Name or by selecting a 
specific historical table.
In the figure above tank TK001 has been bound to the product capacity table named TK001 
which was previously defined in the Tank Capacity Table utility and saved to the Tank 
Capacity Table database.

It is not necessary to use the same name for the Tank and the Table but this 
nomenclature has been used for the default tables for historical reasons.
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7.3.3 Density Tables
In this section the chosen Density Table is bound to the selected tank.

BA00390GEN_0167

In this case tank TK002 is bound to density table DensityTable1 which has been previously 
defined in the Density Table option and has been saved to the Density Table database.

It is not necessary to use the same name for the Tank and the Table but this 
nomenclature has been used for the default tables for historical reasons.

7.3.4 Roof Details
The Roof Details section contains data that is relevant to floating roof tanks i.e. those that 
have been defined with a tank shape of VCFR.
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Leg Position
Some floating roofs have legs which may be set at two positions, thus altering the level at 
which the roof floats or is supported on the legs. Since the legs are usually attached to the 
floating roof, the up position of the legs allows the roof to descend to a lower level in the 
tank, and is the setting used in normal operation, whereas the down position causes the roof 
to become supported on it's legs at a higher level and is the setting used for maintenance 
purposes.
Where a tank has a floating roof with fixed or one-position legs, it is advisable to set the Legs 
Up and Legs Down levels to be the same, so that the Legs Up/Down selection becomes 
irrelevant.

Fully Floating Level, Legs Up
The point at which the roof just ceases to be resting on its legs when the legs are in the up 
or operational position, such that the whole weight of the roof is being supported by its 
buoyancy in the product. Above this level, compensation is made for the displacement of the 
product by the full weight of the roof.

Fully Floating Level, Legs Down
The point at which the roof just ceases to be resting on its legs when the legs are in the down 
or maintenance position, such that the whole weight of the roof is being supported by its 
buoyancy in the product. Above this level, compensation is made for the displacement of the 
product by the full weight of the roof.

Fully Supported Level, Legs Up
The point at which the roof legs are supporting the full weight of the roof when the legs are 
in the up or operational position. Below this level, no compensation is made for product 
displacement caused by roof weight.
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Fully Supported Level, Legs Down
The point at which the roof legs are supporting the full weight of the roof when the legs are 
in the down or maintenance position. Below this level, no compensation is made for product 
displacement caused by roof weight.

The area between the Fully Supported and Fully Floating levels is generally referred to 
as the roof transition zone. Between these levels it is difficult to determine the 
proportion of the roof's weight which is being held by the legs and therefore difficult to 
calculate the displacement of product by the roof. For this reason this region of the tank 
is normally avoided during normal operation.

7.3.5 Tank Correction

BA00390GEN_0030

This page details various settings used for tank / gauge corrections.

Shell Insulation Factor
1 for completely insulated storage, 0 for un-insulated storage, 0.875 is a typical value.

Shell Expansion Coefficient
Expansion coefficient of the material your tank is constructed of, e.g. 0.0000112 for mild 
steel.

Shell Reference Temperature
Normally the same reference temperature used for your VCF calculations (normally either 
15 °C or 30 °C).
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Manual Air Temperature
The manual air temperature setting, if your gauge can provide an automatic air temperature, 
then leave it unchecked.

Gauge Temperature Coefficient
The linear coefficient of thermal expansion for the gauge and it’s mountings. The typical 
values are the same as those for Shell Expansion Coefficient.

Gauge Reference Temperature
The temperature at which the gauge was calibrated.

Float Diameter
Diameter of the gauge float.

Float Weight
Weight of the gauge float.

Float Reference Density
The density of the fluid in which the float was calibrated.

7.3.6 Miscellaneous

BA00390GEN_0169

This section contains various housekeeping features that for the most part do not affect the 
behavior of the system, but are provided for operators to note additional information about 
the tank.
The exceptions to this are as follows:
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Lowest Element Position
Is the level of the lowest temperature element. If the level falls below this value, then the 
Product Temperature is marked as invalid – represented by a DN99 error code on screen.

Percentage Level and Volume Settings
Determine what data parameters are used to produce the percentage level and percentage 
volume values.

In the screenshot above:
Percentage Level =  (Product Level)/(Level Extent)
and
Percentage Volume =  (Total Observed Volume)/(Maximum Operating Volume)

7.3.7 VCF Settings

BA00390GEN_0032

This section contains various settings applicable to Volume Correction Factor calculations. In 
previous versions, some of these settings were available in ‘Manual Data’.

For example:

•The ‘Enraf polynomial’ constants are only made available when an Enraf volume 
correction method is selected.
•Alcohol strength by volume (→ ä 25).

7.3.8 Inventory Control Settings

Calculation control settings
The settings on these pages control the way the inventory calculations are performed. The 
default settings are modified by clicking on the arrow, and selecting the new setting from 
dialog.
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Setting 1 (unset) Setting 2 (Set) Explanation

Disable tank shell correction. Enable tank shell correction. When checked the tank shell correction 
calculation will be performed, enter shell 
correction information on the relevant tab in 
this module.

Do not apply hydrometer 
correction in VCF.

Apply hydrometer correction to 
VCF.

Set according to whether hydrometer 
correction is required or not.

WCF uses Table 56 correction. WCF uses fixed 0.0011 kg/l. Select this to use a calculated WCF, which 
gives better accuracy when calculating WCF.

Use IP calculation of TOV/GOV. Use API calculation of TOV/GOV. Set if you wish to use American (US) style 
calculations, which perform the floating roof 
and free water corrections at a different 
stage to the British calculations..

Disregard suspended sediment 
and water.

Include suspended sediment & 
water.

Set if you want include sediment and water 
correction in your inventory calculations.

Combined sediment and water 
calculation.

Separate sediment & water 
calculation.

Set if you want sediment and water 
correction calculated separately.

Water density 1.0 kg/l for 
fresh water

Water density 1.020 kg/l for sea 
water

Set according to whether the water you have 
in your tanks is fresh or sea water.

Tank calculated as hydrocarbon 
storage.

Tank calculated for ballast/slops 
storage.

When set movements in and out of the tank 
are assumed to leave a constant oil depth 
and vary the amount of water in the tank.

Dip thermal correction is 
disregarded.

Dip thermal correction is 
enabled.

Set if correction for temperature is applied to 
dip.

Gauge dip type is Ullage. Gauge dip type is Innage. If ‘Dip thermal correction’ is enabled, selects 
which type of gauge to apply correction to.

Disable correction for Buoyancy 
gauges.

Enable correction for Buoyancy 
gauges.

When set, correction is applied for buoyancy 
type gauges.
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Input Control Settings

BA00390GEN_0170

Net values calculated from 
gross.

Net values calculated from NOV-
NSV chain.

If set, net values are calculated from gross, 
otherwise from prior calculated NOV and 
NSV values. Only applicable to IP calculation 
methods.

Mass calculated from standard 
conditions.

Mass calculated from observed 
conditions.

–

Range checking is enabled. Range checking is disabled. If set, checks to ensure input values are 
within acceptable range are turned off.

Compressibility factor is 
disregarded.

Compressibility factor is applied. If set, the compressibility factor will be 
applied to calculations.

Tank shell is not insulated. Tank shell is insulated. If set, tank shell insulation will be included 
in calculations.

WCF uses main Table 56 WCF uses short Table 56. Weight correction factor calculations use 
‘Table 56’. This exists in a ‘short’ or ‘main’ 
version. If set, the short version will be used.

VCF is normal. VCF is restricted. When set, VCF output is restricted to 4 
decimal places.

Use equilibrium pressure as per 
D1250/04.

Use equilibrium pressure as per 
D1250/04 addendum 1.

When set, the 2007 addendum to MPMS 
11.1 D1250/04 regarding equilibrium 
pressure is applied.

Setting 1 (unset) Setting 2 (Set) Explanation

Setting 1 (unset) Setting 2 (Set) Description

Gauge levels are innage. Gauge levels are ullage. The levels returned by the gauge are innage 
(referenced from the bottom) or ullage 
(referenced from the top).
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Ullage level zero = Max. 
Operating Level.

Ullage level zero = Reference 
Height.

Zero ullage is taken as the highest safe 
working level or the maximum height of the 
tank.

Gauge reads reference density. Gauge reads observed density. Use this setting with care! When set the 
inventory calculator derives the reference 
density from the observed density 
information, if you enter manual densities 
be aware of whether you enter a reference 
density or an observed density.

Gauge reads density in vacuum. Gauge reads density in air. When set an allowance for the density of air 
will be made during inventory calculations.

Gauge reads relative pressure. Gauge reads absolute pressure. Internally pressures are stored in Bar 
absolute, checking this option will cause the 
pressure stored to be calculated from the 
gauged value.

Tonnes/hour flow rate 
specified in air.

Tonnes/hour flow rate specified 
in vacuum.

Check this if you want a mass flow rate as 
opposed to a weight flow rate.

Roof weight specified in air. Roof weight specified in vacuum. If you know the mass of your floating roof, 
set to Roof Weight Specified in vacuum.

Use product temperature in 
vapour correction.

Use vapour temperature in 
vapour correction.

Sets which temperature is used by vapour 
correction.

Average gauge temperature is 
product temperature.

Average gauge temperature is 
vapour temperature.

Selecting vapour temperature as the source 
of average temperature disables product 
temperature.

Liquid pressure is from P1. Liquid pressure is from P2. Determines where liquid pressure is read 
from.

Debug output is enabled. Debug output is disabled. When set, debug logging is enabled. Not 
available to users, internal flag only.

Setting 1 (unset) Setting 2 (Set) Description
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8 Alarm Configuration
A very configurable alarm/event sub-system comes with the system.

The use of this feature can be controlled by the security system.

8.1 Alarm Overview
The alarm/event sub-system is based upon a Windows service.
The alarm system consists of an EventServer which distributes alarms and events as they 
occur to any connected AlarmEventViewer clients.
The EventServer may be configured to distribute only a sub-set of alarms to individual 
AlarmEventViewer  clients and each client may be configured to display and annunciate 
alarms as required.
The AlarmEventViewer is the principle way of viewing alarms and only one instance runs per 
machine, although multiple client machines may connect to a single EventServer.
The following is typical of an Alarm Event Viewer:

BA00390GEN_0171

8.2 Event Server Configuration
The Event Server’s role is to send new alarm notifications to any Alarm Event Viewer clients 
connected to the system. These could be locally on the same PC or on networked client PCs.

The Event Server may be configured for a range of functions, including:
• Defining the severity of alarms.
• Defining what text to display for an alarm.
• Determining what alarms are sent to individual clients.

The Event Server also monitors the health of the alarm sub-system and if any of the 
following services fail, then an Event Subsystem Failed alarm will be sent to all client 
viewers:
• Hermes
• DCCHost
• RTDBAccessor

8.2.1 Configuring the Event Server
To configure the Event Server, proceed as follows:

Right click on the Service Manager icon in the Windows system tray and selecting the 
Event Server Service → Event Server Config option.

1.
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Expand the left hand panel to select one of the areas to edit, or click on the underlined 
item in the right hand panel.

The four selections are:
• Settings: Configure the internal settings for the Event Server
• Clients: Configure any unique client definitions
• Events: Configure the definition for each alarm/event type
• Databases: Configure the database maintenance parameters

There are toolbar icons to add/remove a client, override or remove over-ride for an alarm 
and to change event options.

2.
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8.2.2 Settings
This page allows various settings for the Event Server itself to be configured. Generally 
speaking, most of these should be left as their default values.

BA00390GEN_0265

The following settings may be configured:

TCP Port
This is the network port used to listen for connections from Alarm Event Viewer clients. If 
this is changed then any Alarm event Viewer client should have their configuration changed 
to match it. This value should only be changed if there is a clash with some other software 
running on the PC.

Interval
This is the update time for the server, increasing it will slow down alarm updates. It should 
not be changed unless the PC is running at a very slow speed.

Sender E-Mail Address
This is the e-mail address displayed in the sender field of any e-mails that are sent 
containing alarm details.

Ack Duplicate Events
By default this item is ticked, in which case if there are multiple occurrences of the same 
alarm in the database then acknowledging one will acknowledge all of them. If this item is 
unticked then each alarm has to be individually acknowledged. This should only be unticked 
if clients are using the Legacy Mode for events.
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Log Exceptions
If this is ticked then any problems that the server encounters will be logged to a file on the 
hard drive. The file will be called Event.Server.Exceptions.txt and will be located in the 
standard install directory for tankgauging.
It may be useful to log errors to assist in diagnosing network access problems.
For instance if a remote client on the network is not receiving automatic updates of events 
then it may be due to a number of problems such as the Windows firewall blocking on the 
client. This would show up in the log file on the server.

Redundancy Settings
This setting needs to be configured to create alarm synchronization among the redundant 
pairs. Alarm synchronization means that acknowledging alarms on one server automatically 
acknowledges the alarms on the second server. By default this option is unticked. Selecting 
this option enables the following options.

Local Sync Port
Port number used by the local Event Server to listen for connections from the remote Event 
Server on the redundant partner machine. This can be any number and that needs to be 
provided as the Remote Synch Port in another server.

Remote Sync Port
Remote port number used by the local event server to listen for connections from the local 
Event Server on the redundant partner machine. This number should be same as the Local 
Sync Port on the other server.

Remote Sync Host
Host Name of the redundancy partner.
The above settings need to be completed on both servers.
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8.2.3 Client Definitions
This page allows the alarm/event sources for clients to be configured. For example, clients 
can be configured to only receive alarms for a sub-set of the tanks, or to receive nothing at 
all.

BA00390GEN_0039

Show settings for
To display a client definition, select it from the Show settings for list. All parameters on the 
screen will be set to the selected client.

The client name is either:
• The name of the client PC on the network (including the name of the PC that the server 

runs on, as the Alarm Event Viewer on that machine counts as a client), and must be 
unique.

• The telephone number of a mobile telephone which is to be used as an SMS client.
• The e-mail address which is to be used as a client for e-mailing alarms.
• The port name which is connected to an ASCII printer which is to be used to output alarms. 
• The telephone number of a telephone which is to be used as a voice client.
• The name of a radio network (configured in the messaging service) which is to be used to 

broadcast alarms as radio messages.

Add Client
Clients may be added or deleted as required.
There is always a client called default which cannot be deleted and this is used as the 
definition for a connecting client if one does not exist. For most standalone systems no extra 
client definitions are required, as the default will be used.

To display a client definition:

Select it from the Show settings for list. All parameters on the screen will be set to the 
selected client.

To add a new client definition:

Click on the Add Client button

1.

1.
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Select the type of client required:

Click OK and the new client will be displayed in the list and the parameters will be 
cleared.

Delete Client
To delete a client definition:

Select the client in the list and click on the Delete Client button.

Deleting a PC client definition will not stop the client from receiving alarms. It will 
simply use the default definition.

For each client the following parameters may be configured:

Legacy Mode Events
This sets the client in the same mode as used on older versions of the tank gauging system, 
where multiple occurrences of the same alarm will each have their own entry displayed and 
will have to be acknowledged individually.

2.

Client Type Identity Details

PC Client Client Name The name of the client PC on the network.  
This can either be typed in, or selected from 
the dropdown list of available PCs.

Mobile Phone (SMS) Phone Number Only available if the feature is licensed. The 
telephone number of the mobile phone 
which is to act as an SMS client.

E-Mail (Plain Text) E-Mail Address The e-mail address which is to act as a 
recipient of plain text e-mail messages 
containing alarm details.

E-Mail (HTML) E-Mail Address The e-mail address which is to act as a 
recipient of HTML e-mail messages 
containing alarm details.

ASCII Printer Port Name The name of the COM port the ASCII printer 
is connected to.

Radio Radio Only available if the feature is licensed.  
Selected from a dropdown list of the radio 
networks configured in the messaging 
configuration.

Telephone Phone Number Only available if the feature is licensed. The 
telephone number of a phone which is to act 
as a voice client. There is an additional field 
(Use Outside Line) which indicates if an 
outside line is to be used as configured in the 
messaging service configuration.

3.

1.
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Display System Events
Certain alarms or events are defined as system events, such as system failure events etc. The 
annunciation of these can be prevented on a client by unticking this box.

Display Movement Events
Events generated by the Movement Server service can be stopped from being annunciated 
on a client by unticking this box.

Display Communications Events
The DCC Host service generates a range of communication events, such as Communication 
Failure events, or Failed to Connect events etc. These can be stopped from being annunciated 
on a client by unticking this box.

Display Device Events
Device events are the main set of alarms generated for tanks, such as Level Alarms, 
Temperature alarms  etc. These can be stopped from being annunciated on a client by 
unticking this box. These represent the main events in the tank gauging system and 
generally should not be disabled.

Display Selected Events
This allows the filtering of events so that only specified events are sent to the client.

Only Display Selected Severities
This allows the filtering of events so that only events of specified severities are sent to the 
client.

Select Devices
It is possible to configure a client to only receive events from specific devices/gauges. These 
can be specified by clicking on the Select Devices button.
This will launch the Select Devices screen:

BA00390GEN_0041

To add a device, choose the Selected Devices button highlight it on the list and click the OK 
button. To delete a device, deselect it in the list and click the OK button.

Select Events
It is possible to configure a client to only receive specified events. These can be specified by 
clicking on the Select Events button (only available when the Display Selected Events field 
has been ticked). 
This will launch the Select Events screen:
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To add an event, select it from the list and click OK button. To delete an event, deselect it in 
the list and click the OK button.

Select Severities
It is possible to configure a client to only receive events of specified severities.  These can be 
specified by clicking on the Select Severities button (only available when the Only Display 
Selected Severities field has been ticked).
This will launch the Select Severities screen:
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To add a severity, select it in the list and click the OK button. To delete a severity, select it in 
the list and click the OK button.
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8.2.4 Event Definitions
This page allows the definition for each event (an alarm is just a type of event) to be 
configured. This includes the event/alarm text to be displayed on screen and its severity.

BA00390GEN_0044

All the possible events that the system can generate are displayed in the list.
Selecting an event will show its settings in the fields below.
For each event the following may be configured:

Event Text
This is the text that will be logged to the events database and displayed on the EventViewer 
screen.

Audio Message
This is the message which will be annunciated for radio and telephone voice clients. If no 
message is set up, the event will not be annunciated. To edit the message click on the  
button next to the field. This will bring up an audio messaging edit screen:
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For more details on configuring audio messages, → ä 171. The number of times that the 
message is repeated and the interval at which the message is repeated can be overridden 
(only relevant for radio messaging, not telephone messaging). To override the number of 
times the message is repeated, tick the Override Default Repeat field and then select the 
number of times the message is to be repeated. Similarly to override the repeat interval for 
the message, tick the Override Default Repeat Interval and select the interval at which the 
message is to be repeated. Telephone messages will only ever be annunciated once 
regardless of these settings.

Severity
There are four options:
• Critical
• High
• Low
• Log Only

These refer to the priority given to the alarm.
LogOnly alarms will never be displayed in any Alarm Event Viewer clients, but will be saved 
in the events database and may be viewed in the Event Search screen. They are 
automatically acknowledged by the system.

Requires acknowledgement reason
If this box is ticked, the user will be required to enter an acknowledgement reason when they 
acknowledge this type of alarm.
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8.2.5 Database Maintenance
This page allows parameters to be specified to prevent the events database growing to an 
unmanageable size.

BA00390GEN_0046

Auto Ack Events
This field is to be ticked if events are to be automatically acknowledged after a given time 
period. This should only really be used on redundant systems where it is possible that no 
client machines are connected to a particular server and hence the events will never be 
acknowledged, or the user may be swamped with events when a server changeover occurs.

Ack Events after 
This field is used to specify the number of days after which events should be acknowledged.

Auto Truncate Events
This field is to be ticked if events are to be deleted from the events database after a given 
period.

Retain Events for
This field is used to specify the number of days after which events should be deleted from 
the events database.

Auto Truncate Audits
This field is to be ticked if audit events are to be deleted from the events database after a 
given period.

Retain Events for
This field is used to specify the number of days after which audit events should be deleted 
from the events database.
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8.3 Alarm Event Viewer Configuration
To configure the Alarm Event Viewer, proceed as follows:

Choose View → Options from the menu.

BA00390GEN_0047

The following screen will be displayed:

BA00390GEN_0048

To choose the type of options to configure, either select them from the list on the left or 
click on the relevant text on the right.

1.

2.
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8.3.1 Severity Options
The screen for severity options is shown below.
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Show settings for
The drop down list at the top of the page is used to select the severity of the alarm for which 
the options are to be set. Changing the options will only affect the alarms of that severity.

Use Defaults
Reverts all the options for the severity back to their default values.

Background Colour
The background colour to be used to display the severity of an alarm.

Text Colour
The text colour to be used to display the severity of an alarm.

Text
The text to be displayed to indicate the severity of an alarm.

Sound File
The sound file to be played when an alarm of this severity is the highest priority and sound 
is enabled (see Notification Options). If no directory is supplied the file must exist in the 
Media directory contained in the application directory.
• To browse for a new sound file click on the button to the right of the sound file field.

Test
To play the currently selected sound file click on the Test button.

Sample
Indicates how the severity of the alarm will be displayed in the list of alarms.
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8.3.2 Filter Options
The screen for filter options is shown below:
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These options specify how the alarms will be filtered within the alarm event viewer.

Severity
This section allows the filtering of alarms based on their severity.

Display → Silenced Alarms
If this option is ticked, alarms that have been silenced but not acknowledged will be 
displayed in the list.  Otherwise the alarm will be removed from the list when it has been 
silenced even if it has not been acknowledged.

Display → Still Active Alarms
If this option is ticked, alarms that have been acknowledged but are still active will be 
displayed in the list. Otherwise the alarm will be removed from the list when it has been 
acknowledged even if it is still active.

Rows
Allows the user to specify the maximum number of rows to be visible in the list when the 
alarm event viewer is docked at the top or bottom of the screen. All alarms will still be 
present in the list and if the number of alarms is more than the value entered a scroll bar will 
be displayed to allow the user to view details of all the alarms.

Sorting
Allows the user to sort the alarms by Severity, Description, First, Last and Active.
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8.3.3 Visibility Options
The screen for Visibility Options is shown below:
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The first panel on this page allows the user to specify the conditions under which the Alarm 
Event Viewer can be minimized or hidden. This also works in reverse, in that if a new alarm 
is raised which does not meet these conditions the Alarm Event Viewer is redisplayed on 
the screen if it is hidden or minimized.

Hide device number for device alarms alters the description displayed on the main Alarm 
Event Viewer window to either show or hide the Device ID. See screenshots below. If your 
site has only one level gauge per tank, then showing the Device ID may not be necessary.

BA00390GEN_0259

Alarm Event Viewer with Device ID hidden

xxxxx

Alarm Event Viewer with Device ID shown
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8.3.4 Notification Options
The screen for Notification Options is shown below:
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Play sound for → Most severe alarm
The 'active' alarm is considered to be the oldest unacknowledged alarm of the highest 
severity, i.e. there may be older unacknowledged alarms but these are of a lower severity 
than the 'active' one.

Play sound for → Oldest alarm
The 'active' alarm is considered to be the oldest unacknowledged alarm irrespective of 
severity.

Play sound relating to → Severity of alarm
The sound relating to the severity of the 'active' alarm (→ ä 56) is continuously played until 
the alarm is acknowledged.

Play sound relating to → Audio message
The audio message configured for the alarm (see events configuration) is played once.

Play sound relating to → Type of alarm
The sound relating to the type of the 'active' alarm is played once. This is typically an 
annunciation of the alarm type. These sounds can be edited by pressing the Edit button 
(which is only available when this option is selected). Pressing the Edit button causes the 
following screen to be displayed:
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This list indicates the sound file that will be used for each type of alarm. The file can be 
changed by typing the new file name into the relevant field. Alternatively a new file can be 
selected by clicking on the button which is available when a file name is being edited. If 
no file is entered for an alarm type, the text for the alarm type will be annunciated using the 
Windows Speech Engine. To test the sound that will be played for an alarm type click on the 

 button in the row for that alarm.

Silence Alarm
Allows the user to change the combination of keys that can be used to silence the currently 
selected alarm.

Acknowledge Alarm
Allows the user to change the combination of keys that can be used to acknowledge the 
currently selected alarm.
The alarm volumes can be altered or muted using the next screen option.

BA00390GEN_0054
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8.3.5 Connection Options
The screen for Connection Options is shown below:
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Show settings for
The drop down list at the top of the page is used to select the server type for which the 
options are to be set. Changing the options on the page will only affect the settings for that 
server type.

Use Defaults
Reverts all the options for the server type back to their default values.

Server
The name of the server to be used for this server type. This can either be typed in directly, or 
selected from the drop down list. Depending on the speed and configuration of the network 
this list can take some time to be fully populated.

TCP Port
The TCP port on which the events service is running on the specified server.

Test
Tests that the events service can be found on the given combination of server and tcp port.



Alarm Configuration Tankvision Professional NXA85 - System Configuration

62 Endress+Hauser

8.4 Programmable Alarm Configuration
An integrated part of the system is the Alarm Configuration module.
A wide range of programmable alarms are provided allowing the operator/user to have 
control over product movement.

8.4.1 Launching Alarm Configuration
To launch the Alarm Configuration module, proceed as follows:

Select the Alarm Configuration option from the Configuration menu.
The following display is typical:

BA00390GEN_0178

Expand the Tank to show the different types of alarms that can be configured.

Select one of the alarm groups.

1.

2.

3.
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Theft Alarm
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The Theft Alarm is similar to the Unauthorised Movement Alarm except that it only 
detects a loss of product and ignores gains. It also has a number of extra features, specific to 
theft monitoring. When the alarm is enabled the current GSV is stored as a starting value 
and any reduction in the volume greater than the threshold figure will then trigger the 
alarm. If the GSV increases then the starting value will be set to the new GSV value, thus it 
will automatically take account of any receipts of product. Once a Theft Alarm has been 
triggered it will reset itself after a user defined period and re-arm with the current GSV as a 
starting value. Note that after using this tool it is necessary to start and stop services using 
DCC Config to set up the alarm.
The Theft Alarm will only be monitored during user defined periods (i.e. during nights and 
weekends); outside of these periods no alarm will be generated even if the theft alarm is 
enabled. To configure the monitoring periods and the alarm reset period, the software tool 
"Theft Monitor Config.exe" is used. This is located in the standard installation directory: 
C:\program files\Common Files\Tank Farm automations\Server. 

It has three configuration screens:
• Alarm reset – minutes and seconds (time before alarm is reset)
• Day of week - Timed (between x and y hours) / on all day / off all day
• Day of Year - Timed (between x and y hours) / on all day / off all day

These allow for holidays to be programmed into a theft alarm schedule.

After using this tool it is necessary to start and stop services using DCC Config to set up 
the alarm.

• Threshold - an operator configurable threshold to determine when a Theft alarm should 
be raised.
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Gauge Alarms
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Gauge alarms are those alarms that are generated by the gauging instrument itself. The 
alarm levels displayed here are normally only there for reference purposes.
On some modern technology gauges it is possible to read the gauge alarm settings from the 
gauge automatically.
On older gauges this is not possible and provision is made to enter these manually within 
through this module.

Detection of gauge alarms is done by the gauging instrument and not by the Tankvision 
Professional software. Tankvision Professional merely reads the status of the alarm 
bits transmitted to it by the gauge.
Gauge alarm settings are normally set by the gauge commissioning engineer.

• Gauge Alarm High High - The gauge high high level alarm setting.
• Gauge Alarm High - The gauge high level alarm setting.
• Gauge Alarm Low - The gauge low level alarm setting.
• Gauge Alarm Low Low - The gauge low low level alarm setting.
• Gauge Alarm Enable - An operator configurable enable flag.
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Difference Alarm
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For example a tank fitted with two gauges will have one nominated as the primary gauge 
and the second as a secondary gauge. The system can then monitor the difference between 
the two gauge levels, and compare the difference to the allowable tolerance set by the user. 
If the difference exceeds the tolerance a difference alarm will be generated.

• Difference Alarm Enable - an operator settable signal to determine if the alarm is 
enabled or not.

• Difference Alarm - an operator configurable difference alarm.
• Difference Alarm Hysteresis - operator configurable hysteresis for difference alarm.

If a hysteresis value above the Allowable Tolerance is entered then the following warning 
message is displayed:
Hysteresis is above the Allowable Tolerance!

Click the OK button to clear the warning.
A hysteresis value below the Allowable Tolerance must be entered.

1.
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Deviation Alarm
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The deviation alarm is used to alert operators to layering occurring in the tank. When two 
consecutive profile points deviate by the specified amount, either in their density readings 
or temperature, an alarm will be generated. This alarm requires the use of gauges capable of 
returning density profiles.

• Deviation Alarm Enable - enables and disables the alarm.
• Density Profile Deviation - deviation amount, for density points.
• Temperature Profile Deviation - Deviation amount, for temperature points.
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Unauthorised Movement Alarm
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The unauthorised movement alarm is intended to protect against inadvertent movement of 
product in static tanks. The "Unauthorised Movement by Volume/Level" or Leak Alarm can 
be enabled on systems where the Movements sub-system is not in use. This alarm should be 
enabled when the tank is to remain static, this has the action of internally storing the current 
GSV for the tank, should the GSV in the tank change beyond the predefined threshold limit, 
then the alarm will be triggered. The alarm should be disabled when movement of product 
into or out of the tank is being done.
This alarm is often referred to as a Leak Alarm although it equally refers to a gain of product 
as well as a leak. The application refers to these as unauthorised movements.

• Threshold - an operator configurable threshold to determine when an Unauthorised 
Movement alarm should be raised.
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Movement Alarms
In some circumstances it is necessary to reduce the sensitivity of the Unauthorized 
Movement and Theft Alarms. Typical reasons are that radar gauges on empty tanks can give 
spurious jumps in level that would be detected as an Unauthorized Movement or that high 
winds acting on a floating roof tank cause the levels to "swing". In such situations the 
Unauthorized Movement and Theft Alarms can become a nuisance, distracting the 
operators from the real dangers on their site.

BA00390GEN_0261

Use Smoothing for Movement Alarms – apply smoothing to the volume and level used to 
test for the Unauthorised Movement Alarm and the Theft Alarm. The smoothing uses the 
same parameters entered for the flow calculations, i.e. Flow Rate Damping and Flow Rate 
Integration. These are entered in the Device Configuration screens.
Use Noise Reduction for Movement – is similar to the above, but employs a two out of three 
voting mechanism to discard "jumps" in level which can be caused by radar gauges. Each 
successive level reading from the gauge is compared with the previous two readings, the 
most extreme reading is discarded and the level in the tank is considered to be the average 
of the two remaining. In this way outlier readings (i.e. jumps in gauged level) are discarded.

These settings have no effect on the product level and dependent inventory volumes 
and masses, it is only the levels and volumes used by the Unauthorised Movement and 
the Theft Alarm  detection mechanism that are altered.
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Flow Alarms
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The flow alarms are intended for use when tanks are moving. They are useful to detect that 
flow has exceeded a tank or pipeline design limit or that flow has reduced or stopped perhaps 
due to some fault.
The alarms are configurable for up to 3 zones. The zone transition boundaries for Rising level 
alarms and Falling level alarms can be independently configured.
Transition boundaries may be dragged to the required level or selected and the required level 
typed into the Level entry field.
Flow rates for each zone may be entered by selecting the required zone and typing the Min 
Flow Rate and Max Flow Rate into the appropriate entry field.

Entering a negative value disables an alarm.

Alternatively, clicking the Text link in the top right of the window switches from Graphical 
to Text entry.

BA00390GEN_0064
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Programmable Level Alarms
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Programmable level alarms are triggered according to the gauged level, they can be used on 
gauges where hardware alarms are not available or used in addition to the gauge hardware 
alarms.

• Level Alarm High High - an operator configurable level alarm denoted High High.
• Level Alarm High - an operator configurable level alarm denoted High.
• Level Alarm Low - an operator configurable level alarm denoted Low.
• Level Alarm Low Low - an operator configurable level alarm denoted Low Low.
• Level Alarm Hysteresis - an operator configurable hysteresis value.
• Level Alarm Enable - an operator configurable enable flag.

The term High High is normally associated with the extreme upper limit to which a 
tank would be filled. Under normal operating conditions it would be unusual to trigger 
this alarm.
Consequently the term High is not as extreme as High High and is normally set a small 
distance below the High High limit.
The term Low Low is normally associated with the extreme lower limit to which a tank 
would be emptied. Under normal operating conditions it would be unusual to trigger 
this alarm.
Consequently the term Low is not as extreme as Low Low and is normally set a small 
distance above the Low Low limit.
Clearly it is essential that all the alarms being used are configured correctly.

The programmable level alarms have equivalent gauge alarms. The programmable alarms 
would normally be set slightly below and slightly above there respective gauge alarm values. 
The programmable alarms would normally be used as early warnings to the gauge alarms.
However the user can choose to use them as required although it is recommended that they 
are used within the context of the definition of the alarm to avoid confusion.
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Programmable Water Alarms
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Water alarms are triggered when tank water levels exceed the limits specified. If you do not 
require a low water alarm, set the low level to a negative value.

• High Water Level - an operator configurable free water level, above which the alarm will 
be triggered.

• Low Water Level - an operator configurable free water level, below which the alarm will 
be triggered - If a low water warning is not required set this to a negative value, to prevent 
it occurring.
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Floating Roof Alarm
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The purpose of the Floating Roof alarm is to provide the operator with the option of 
generating a warning when the product level starts to approach the point where the roof 
starts to rest on its legs. Under normal operating conditions this is generally undesirable; 
therefore the alarm has been provided for that purpose.

• Enabled - when selected, the Floating Roof Alarm will be activated when the product level 
falls below the Roof Early Warning Level. The alarm will be cleared when the product level 
rises above the Roof Early Warning Level by more than the Roof Warning Hysteresis.

• Roof Early Warning - an operator configurable set point determining at what level the 
alarm will be generated. The level would normally be programmed above the Roof Fully 
Floating level set in the Tank Characteristics module.

• Roof Warning Hysteresis - the operator configurable distance by which the product level 
must return above the Roof Early Warning Level in order to clear the Roof Early Warning 
Alarm.
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Programmable Temperature Alarms

BA00390GEN_0188

These are operator programmable temperature alarms.

• High - an operator configurable high temperature alarm.
• Low - an operator configurable low temperature alarm.
• Hysteresis - an operator configurable temperature hysteresis.
• Enabled - an operator configurable temperature alarm enable.
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Density Alarms
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These are operator programmable density alarms.

• High - an operator configurable high density alarm.
• Low - an operator configurable low density alarm.
• Hysteresis - an operator configurable density hysteresis.
• Enabled - enables and disables the alarm
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8.4.2 Modifying Data within Alarm Configuration
To modify data within the Alarm Configuration module, proceed as follows:

Select the tank to be modified from the list and the type of alarm to be modified.
The current details for the alarm for that tank will be displayed.

Take note that if this is the first time Alarm Configuration has been loaded after 
installing the system it will be displaying default values. It is essential that default 
values are replaced with the correct operating values.

Select the field to be edited and type in the new data values.

Each field is validated both during data entry and just before the data is saved to the 
database.
You can use the TAB key to move to the next entry field.

If the changes made are correct and you want to save them, press the Apply button to 
save the changes to the database.

To edit further tanks follow the same procedure.

If you want to abandon any changes made since the last time the Apply button was 
pressed, press the Cancel key.
This will also exit the application.

To exit the application, either close the Window or press the Cancel or OK buttons.

8.4.3 Generation of Alarms
Normally in a standalone configuration the alarms are detected and generated by the Data 
Communications Control module. It is this module that sees the changes in gauge data first.
In a client-server system it is the same module that detects and reports the alarms although 
it is important to note that this module will only be running on the server.
Any client connected to the server will therefore see the same alarms.
Some events may be generated locally by each client. These are normally events in response 
to abnormal operating data or transient or irrecoverable data access errors.

8.4.4 Enabling and Disabling Alarms
Enabling an alarm means that the variable associated with the alarm will be monitored 
against its set limits and when it deviates outside of those set limits an alarm will occur.
Disabling an alarm means that no alarm processing will take place for the disabled alarm and 
therefore no event, audible signal or otherwise will be generated if the variable goes outside 
of its set limits.

Alarms can generally be enabled or disabled in one of two ways:
• The alarm configuration display provides a check box within each tab for enabling or 

disabling the alarm.
• Alternatively, the pop-up menu allows the user to enable and disable the alarms.

The enabling and disabling of alarms is logged to the audit trail file.

1.

2.

3.

4.

5.
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8.5 User Defined Alarms
User Defined Alarms (Programmable) are a set of alarms which the user may configure 
based on a set point and hysteresis. There are eight alarms User Defined Alarm One to User 
Defined Alarm Eight.

BA00390GEN_0190

There is a drop down box to select the alarm type and a text box to enter the alarm 
description.
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The text that is displayed when the alarm is activated or cleared and the severity is set in 
Event Server Configuration.

BA00390GEN_0072
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8.6 User Defined Alarms (Gauge)
User Defined Alarms (Gauge) are a set of alarms generated by certain gauge types, Bit 
pattern data is received by the application from a Modbus or OPC host which must be 
configured in DCC (see DCC config document). The user may configure the text to be 
displayed when the alarm is activated and cleared. There are 32 such alarms per gauge:

• User Defined Alarm 1
• User Defined Alarm 2
• User Defined Alarm 3
• Etc. etc. up to;
• User Defined Alarm 32

The alarms are available in the database for all gauge types which support Modbus or OPC.

To configure the text and severity, display the Events page of the Event Server 
Configuration utility.

BA00390GEN_0073

From this page the settings for each alarm in the system can be defined.

To show the settings select the alarm from the list.

The user defined alarms are:
• User Defined Alarm 1
• User Defined Alarm 1 Cleared
• User Defined Alarm 2
• User Defined Alarm 2 Cleared
• User Defined Alarm 3
• User Defined Alarm 3 Cleared
• Etc. etc. up to;
• User Defined Alarm 32
• User Defined Alarm 32 Cleared

1.
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The On and Cleared parameters define what text is displayed when the alarm is activated 
and cleared. These should be modified by the user to the required text.
The severity may be set by the user as required.
The Event Server should be re-started to load any new alarm definitions. Use the DCC Config 
applet in the control panel to do this.
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9 Product Configuration
When first installed, the system has no product information.
This function is used to enter the names of the products stored on-site.
Product Configuration can be launched at any time in order to edit and modify existing 
products as well as add new products or delete existing products.
Each product needs to be allocated to a product type. By default, a GENERAL product type 
exists. Other product types can be created using this function.

The use of this feature can be controlled by the security system.

9.1 Product Types
Product Types allow the user to group products that have similar characteristics.

For example, general product types might be configured as:
• DISTILLATES
• SPIRITS
• CRUDE
• HEAVY OILS
• FUEL OIL

The following products may for example be members of the DISTILLATES product type:
• DERV
• KERO
• GAS
• OIL
• JET A1

Similarly, the following products may be members of the SPIRITS product type:
• ULMS
• LRP
• UL 95
• UL 98

And so on.

The system provides features that allow the user to view tanks by product type.
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9.2 Launching Product Configuration
To launch the Product Configuration module, proceed as follows:

Select the Product Configuration option from the Configuration menu.

The following display is typical:

BA00390GEN_0262

The details of the product or product type selected from the list are displayed in the right-
hand pane.
A filter has been provided. This can be useful for locating a particular product when a large 
number of products have been configured. To filter the products, type the filter criteria into 
the text box in the tool bar. Any products whose name contains the filter text will be 
displayed. There is an indication of the number of products included in the filter shown in 
the product/product type list and also on the product type details pane.

1.
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9.2.1 Creating a Product Type
To create a product type, proceed as follows:

Click on the New Product Type  toolbar button.

Enter a name for the product type.

Click Apply or OK to save the new configuration. 
Alternatively click on any entry in the product/product type list with the right mouse 
button and select New Product Type from the menu

BA00390GEN_0195

The new product type will be created and inserted into the list.

9.2.2 Modifying a Product Type
The only item that can be modified for a product type is the name. To modify the name, 
proceed as follows:

Select the product type from the list of product types. 
The existing details will be displayed in the right hand pane.

Edit the name as required and click Apply or OK to save the new name. 
The version number will automatically increment.

1.

2.

3.

1.

2.
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9.2.3 Delete Product Type
Product types that contain products cannot be deleted. Attempting to delete a product type 
which contains products will result in the following error message.

BA00390GEN_0196

In order to delete a product type, all products within the product type must first be 
deleted or moved to a different location.

To delete a product type, proceed as follows:

Select it from the list of product types and click the Delete  toolbar button.

Confirm that the product type is to be deleted in the pop up.
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The GENERAL product type cannot be deleted.

9.2.4 Creating a New Product
To create a new product, proceed as follows:

Select the product type that will contain the product and click on the New Product  
toolbar button.

Enter a name for the product, select a colour to represent the product and, optionally, 
add a product code (up to 8 characters) and a description.

Click Apply or OK to save the configuration. 
The new product will be created and inserted into the list under the currently selected 
product type.

The use of colour is determined by options configured in the System Settings module. 
Please refer to this section for a description of these settings (→ ä 94).

Alternatively click on any product type, or entry within the product type, with the right 
mouse button and select New Product from the menu to create a new product in the selected 
product type.

BA00390GEN_0200
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9.2.5 Modifying a Product
To modify a product, proceed as follows:

Select the product from the list. The existing details for the product will be displayed in 
the right hand pane. The name, colour and description for the product can then be 
modified.

A product can also have a set of characteristics configured which will override the 
corresponding settings in Tank Charcteristics which will then appear grayed out and will be 
fixed for use with the selected product. This is not an exhaustive set of characteristics and 
should not be considered an alternative to configuring tank characteristics for individual 
tanks. It is, however, useful for fixing a set of characteristics for a particular product.

To add characteristics select the product and then click the Add Characteristics  
toolbar button. If a product already has characteristics, then the toolbar button is 
displayed differently  and can be used to remove the characteristics.

If characteristics are removed they will then need to be set on each tank containing the 
product.

A product which has characteristics set can be expanded to show additional entries:

BA00390GEN_0203

Select the entry to show the settings available for each heading:

BA00390GEN_0204

1.
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Refer to the section on Tank Characteristics (→ ä 25) for more details on these settings.

Click the Apply or OK button to save the settings. 

9.2.6 Deleting a Product
To delete a product, proceed as follows:

Select the product from the list and click the Delete  toolbar button.

Confirm the product is to be deleted in the pop up.

4.

1.

2.
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The EMPTY product is required as the default when creating new tanks so cannot be 
deleted, also products which are currently allocated to a tank cannot be deleted.

9.2.7 Relocating a Product
To relocate a product, proceed as follows:

To move a product from one product type to another it can either be dragged with the 
mouse from its current product type to the new product type, or it can be clicked with 
the right mouse button and the new product type selected from the menu.
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9.2.8 Displaying Product Codes
Products may be selected using either Product Names or Product Codes.
To change between names and codes, proceed as follows:

Click on the toggle (  \  ) button in the Product Configuration menu bar. This will 
affect product selection in Tank Characteristics, on the Home page and in the SCADA 
screens.

9.2.9 Saving Changes
To save changes made to products and/or product types, proceed as follows:

Click either the Apply or OK button.

Clicking Apply will save the changes and keep the product configuration screen open 
allowing for further editing. 
Clicking OK will save the changes and then close the product configuration screen.

If a product with characteristics has been modified, then any characteristics of the 
product will be applied to all the tanks that have that product allocated when the 
product changes are saved.

9.2.10 Discarding Changes
To discard any changes made, proceed as follows:

Click the Cancel button. 
The following message will be displayed if there are any unsaved changes.

1.

1.

1.

1.
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Choosing Yes will save the changes and close the product configuration screen. 
Clicking No will discard the changes and close the product configuration screen. 
Clicking Cancel will leave the product configuration screen open so that the changes can be 
verified before continuing.

9.3 Allocating Products to Tanks
Once all the product information has been entered the products can then be allocated to 
their operational tanks.
The Tank Characteristics module is used to allocate a product to a tank.
See the section detailing the Tank Characteristics module for a full and complete description 
(→ ä 25).
Alternatively, the product allocated to a tank can be changed from the Home Page, Single 
Tank Overview and SCADA screens. See the relevant sections in the Operations Manual for 
more details.
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10 Security
The application is provided with its own security and user administration functions. It is not 
dependent on Windows system security for access to its features.
During initial installation an Administrative account is created as part of the Set-up 
procedure. Thereafter additional user accounts can be created by a user with administrative 
privileges.
The security maintenance features are accessed via the Security menu.
The security features should be used carefully to ensure users have the correct access rights 
for their day to day tasks yet prevent unauthorised access to the other features.

10.1 General Security Settings
In order to adjust the general security settings, proceed as follows:

Log on to system as an administrator.

Select the Security Settings option from the Security menu.
The following screen appears:
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User Access rights (from User group) are only applied if Login Enabled.

Adjust the settings according to the explanations below.

Login Enabled
Determines whether the use of logins should be disabled throughout the whole application.
If this option is checked, the system will prompt for a Username and Password before 
providing access.
If this option is not enabled, no login prompt will appear.
Clearly this option needs to be treated with care.

Sound Enabled
Determines whether a sound is played when the user attempts to access an area to which 
they do not have access rights.

Voice Enabled
Determines whether messages are annunciated when the login dialog is displayed.

1.

2.

3.
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Lock screen when no user is logged in
Determines whether the screen is locked when no user is logged in. If this option is ticked 
the screen is locked when the user logs out. Before anything can be accessed on the 
computer, a user must log in.

Show log in reason on log in screen
Determines whether a log in reason is displayed on the log in screen when it is displayed due 
to a user trying to access an area to which they do not have access rights. For example 'View 
Settings access required'.

Show pick list of user names on log in screen
Determines whether a pick list of user names is displayed on the log in screen instead of the 
user name text field. Use of this setting is not recommended since it reduces security.
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10.2 User Maintenance
In order to launch the User Maintenance module, proceed as follows:

Log on to system as an administrator.

Select the Maintain Users option from the Security menu.
The following dialog opens:
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10.2.1 View/Edit Details of an Existing User
To view/edit details of an existing user, select the user in the list. Details of the user will be 
displayed in the User Details area.
If you have access rights to edit users, the following details can be edited.

Name
The name of the user.

Initials
The initials of the user.

User Group
The user group that the user belongs to. It is the user group that determines the areas that 
the user has access to. To edit user groups click the Maintain button.

Disabled
Determines whether the log in for the user is disabled. This can be set explicitly on this 
screen, or automatically by the system depending on the user group when the user 
incorrectly enters their password. To re-enable this user, untick the box.

Force Password Change
Forces the user to change their password the next time that they log in. This can be used in 
conjunction with the Password button to reset their password, but force them to change it 
the next time they log in, so that the administrator doesn't know their password.

Password
Click this button to reset the password for the user:

1.

2.
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10.2.2 Adding a New User
To add a new user, click the Add button. A new user will be added to the list and selected 
ready for editing.

10.2.3 Deleting a User
To delete a user, select them in the list and click the Remove button. If the user is currently 
logged in you will be unable to delete them.

10.2.4 Saving Changes
To save the changes to the users click the Apply button. To save the changes and close the 
screen click the OK button.

10.2.5 Discarding Changes
To discard the changes to the users click the Cancel button. This will discard the changes and 
close the screen.
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10.3 User Group Maintenance
To launch the User Group Maintenance module, proceed as follows:

Log on to system as an administrator.

Select the Maintain Users Groups option from the Security menu.
The following dialog opens:
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10.3.1 View/Edit Details of an Existing User Group
To view/edit details of an existing user group, select the user group in the list. Details of the 
user group will be displayed in the User Group Details area.
If you have access rights to edit user groups, the details can be edited.

Name
The name of the user group.

Automatically Log Out
Determines whether users belonging to the user group will automatically be logged out after 
a given period of inactivity.

Disable User Log In
Determines whether users belonging to the user group will have their accounts disabled if 
they incorrectly enter their password the specified number of times.

Force Password Change
Determines whether users belonging to the user group will be forced to change their 
password after the given number of days.

Password Strength
Determines whether users belonging to the user group will be forced to use passwords of the 
given strength.

1.

2.
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If this option is used, passwords are case sensitive, otherwise passwords are case 
insensitive.

Access rights
To view details of a specific access right click on the  button to the left of it. This will 
show further details:
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Access rights granted for a user group are indicated by a tick. To remove or grant an access 
right click on the box next to it. This will toggle whether it is granted to the user group. 
Clicking on a ‘parent’ access right (for example System Settings above) will remove or grant 
access to all the options underneath it. So, for example, to prevent a user accessing the 
System Settings area, you could untick the box next to System Settings and this would 
remove the ticks from the Read and Modify boxes underneath it. If the access rights under 
a ‘parent’ access right are in a mixed state (some ticked and some unticked), the box for the 
‘parent’ access right will be filled in:
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User Access rights (from User group) are only applied if Login Enabled.

10.3.2 Adding a New User Group
To add a new user group, click the Add button. A new user group will be added to the list and 
selected ready for editing.

10.3.3 Copying a New User Group
A new user group can be copied from an existing one, to make setting up access rights easier. 
Select an existing user group and then click the Copy button. A new user group will be added 
to the list, with the same details as the existing user group, and selected ready for editing.

10.3.4 Deleting a User Group
To delete a user group, select it in the list and click the Remove button. If any users are a 
member of the user group you will be unable to delete it.

10.3.5 Saving Changes
To save the changes to the user groups click the Apply button. To save the changes and close 
the screen click the OK button.

10.3.6 Discarding Changes
To discard the changes to the user groups click the Cancel button. This will discard the 
changes and close the screen.
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11 System Settings
System Settings affect the operation of the entire system. The System Settings option is 
available under the Admin menu.

The use of this feature can be controlled by the security system.

11.1 Using System Settings
To launch the System settings module, proceed as follows:

Select the Admin → System Settings option from the main menu bar.
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To change system settings, proceed as follows:

Enter the required data or change the current settings. For the meaning of the individual 
items refer to the explanations below.

Press the OK button.
The window will close and the changes will be saved to the database.

11.2 Security Settings

11.2.1 Use User Profile
Determines whether a user profile should be used. The user profile is limited to determining 
which tanks can be viewed by a user.

• When checked the user will be asked to logon at start-up on the assumption that the user 
only has access to a limited number of tanks programmed into the system. If the user has 
not been previously configured with a group of tanks no tanks will be in view at start up.

• When not checked the system will be started with the default profile which is show all 
tanks programmed into the system.

See the Tanks By User feature on how to configure a user profile.

1.

1.

2.
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11.2.2 Automatically Generate Unauthorised Movements
Determines whether the movements subsystem should enable and disable the unauthorised 
movement alarm.
If this option is checked the movements subsystem will disable the unauthorised movement 
alarm when a movement is opened for a tank. Similarly the movement’s subsystem will re-
enable the unauthorized movement alarm when a movement is closed and there are no 
more open movements for a tank.

11.3 Calculations

11.3.1 Flow Rate
The flow rate calculation can be made to mimic an MDP system.

11.4 Tank Settings

11.4.1 Use Product Colour
Determines the strategy for use of colour in the tank windows.
When selected the colour representing the product level in the tank will be that which was 
selected for the product in the tank. See the Configuration → Product Configuration 
options which allows the user to configure the colour a product will be displayed in.
When not selected the colour of the tanks is represented by the tank status. For example, if 
the tank is filling the colour of the product is displayed in blue, if the tank is emptying the 
colour of the product is displayed in brown, and if the tank is static the colour is displayed in 
green.

11.4.2 Movement Threshold
Determines the minimum level flow rate that is deemed significant enough to mark a tank 
as moving.
A flow rate of 5 mm/min is correct for most installations, but if your particular site has a lot 
of large crude tanks, for instance, you might want to use a smaller value. The threshold level 
is used to drive the up and down arrows on the tank mimic screens on the main page.

11.4.3 Display Target Levels
Determines if a target level is displayed in the homepage when using simple movements.

11.5 Manual Level Entry

11.5.1 Warn Against Manual Level Entry
Determines whether the user should be warned if they attempt to enter a manual level entry 
that would fall outside the normal operating range of the tank.
For example above the High High level or below the Low Low level.

11.6 Default Tank Manual Data
Determines which data items will be set to manual status by default.
Selecting a data item in this section will force the corresponding item to be set to manual 
status by default when a new device is added to the system.
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12 Auto Startup Configuration

12.1 Description
The Auto Startup configuration allows the user to start any application within the system 
when the PC is rebooted or restarted. This is useful after a power trip for example. Any other 
program on the PC can also be added via the browse option. There is an overall delay (to 
allow for the database and services to start) and each application can be further delayed 
separately. Parameters or arguments may be passed to any application on startup.

12.2 Launching
The Auto Startup Configuration is launched from the windows start menu.
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The configuration window below is opened:

BA00390GEN_0084

12.3 Configuring
Any application from the tank gauging system can be selected.
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In this case the main screen with multi tank view has been selected. The default delay is 
30 seconds and no further delay has been added. The dialog for adding arguments or 
parameters is shown opened.
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The default delay is 30 seconds and a further delay off 20 seconds has been added. The 
dialog for adding arguments or parameters is shown opened.
There is a count-down window displayed during startup.

BA00390GEN_0087
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13 Manual Data
Normally tank data is collected from the field instruments automatically.
Where primary data values are not available or no longer available due to a gauge fault, data 
values can be switched from automatic mode to manual mode.
When in manual mode the data values have to be provided by the operator.
Data that is in manual mode is normally displayed with green text on black background to 
signify that it is manual data. On reports is it normally prefixed with the letter M.
Where tanks are not fitted with gauges but they are still required on the system, the tank 
may be operated with all of its primary data values in manual mode. In this way at least the 
tank inventory is still calculated. 

Gauges that have both level and temperature in manual mode will not be polled by the 
communications layer.

Primary data values are those measurements made by the tank gauging instrument such as:
• Product Level
• Water Level
• Product Temperature
• Product Density
• Pressure

Traditionally, most gauges provide Product Level and Product Temperature measurement 
capability. It is quite common to find that the rest are entered as manual data.
More modern gauging instruments have the capability to measure water level, density and 
pressure automatically. In this case the values would be collected automatically.

The use of this feature can be controlled by the security system.
By default a manual value will not trigger a programmable alarm, DCC Host → Options 
→ Configure ticking the option for alarms on manual data will reverse this 
functionality.

13.1 Launching the Manual Data Entry Module
To launch the Manual Data Entry Module, proceed as follows:

Select from the main application window menu Configuration → Manual Data.
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The following display is typical.
A list of all tanks will be displayed on the left, together with the manual data entry fields for 
the selected tank.

1.
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By default a reduced set of the most common fields will be displayed.
To view the additional fields for a tank click on the advanced  button.

BA00390GEN_0218
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By default any changes to the manual data for a tank will apply to ALL gauges on that tank. 
The individual gauges assigned to a tank can be viewed and edited by clicking on the 
ShowHide Gauges  button.
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In this mode the manual data can be configured for individual gauges.

13.2 Entering Manual Data
To enter manual data, proceed as follows:

Select the required tank/gauge from the list.

Edit the value.

If the variable is not already in manual mode tick the Enabled tick box. When saved this 
will switch the value to manual mode.

The observed density and observed temperature are enabled and disabled together, 
(i.e. you cannot put the density into manual mode without also providing a suitable 
observed temperature).

After all required data has been entered, press the Apply button to save the changes to 
the database.

Any problems in writing the data to the database will be reported to the user via the 
Status bar of the display.

Press the Cancel button to discard any changes and exit the application.

13.3 Putting a Variable into Manual Mode
Manual data can be modified regardless of whether the value being modified is in manual 
mode or not. 

1.
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When a parameter is switched to manual mode, the current data stored in the manual value 
will be utilised. The inventory data will also be calculated using values that are in manual 
mode.

There are essentially two techniques to putting a parameter into manual mode:
• Checking the tick box adjacent to the parameter in the manual data entry module, or
• Selecting the Manual Data option from the pop-up menu on the tank graphic view (see 

below).
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Either has the same effect.

If the pop-up menu is used, the current manual data will replace the automatic value. 
If the current manual values are incorrect you would need to use the Configuration → 
Manual Data module or select Manual Data → Manual Data from the pop up menu 
to update them.
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13.4 Shortcut to Manual Data
When a parameter is set to manual mode, its data is displayed with blue text and black 
background colour. 
From within the tank graphic view, a shortcut to the manual data entry module exists. See 
the illustration below for a pictorial view.
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Double click the parameter in manual mode.
This will launch the manual data entry module for the selected tank.

1.
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14 Data Collection Device & Device Configuration
Gauges may be connected directly to the PC via the gauge vendors interface box e.g. Enraf 
CIU or via the MINI.
When a Date Collection Device is in use it must be configured using the integrated Data 
Collection Device configuration tools.

14.1 Data Collection Device Configuration Step 1
To launch, select Device Configuration in the Configuration menu.

Once open click the Data Collection Device View icon.
Any Data Collection Devices already configured will be shown.

BA00390GEN_0221

Click on any of the editable fields within the display panel on the right of the screen to 
edit.
No Data Collection Devices will appear in the tree view on the left of the screen if there 
are no Data Collection Devices configured.

To delete a Data Collection Devices from the list, click on its icon in the tree view and 
click on the Delete button.
Alternatively, right click on the icon in the tree view and click Delete Data Collection 
Device.

Data Collection Devices must have all devices removed before they can be deleted.

Click the Add Data Collection Device button to add a new Data Collection Device.

Enter the name of the Data Collection Device in the dialog box.

1.
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Each Data Collection Device on a network must have a unique Name. Additionally, the 
name must not duplicate that of any PC which is on the same network. The name may 
comprise up to eight upper case alphanumeric characters, "A" - "Z", "0" - "9", and must be 
identical to the name which has been configured in the Data Collection Device itself.

Select the correct Data Collection Device Model from the drop down list.

The IP Address of the Data Collection Device should be specified as four decimal 
numbers separated by periods ".". A default IP address will be entered depending on the 
model initially selected. The address entered here is for information only and is not 
used by the system as such.
The Role of the Data Collection Device determines its mode of operation within the 
system and is primarily related to redundant configurations which feature duplicated 
Data Collection Devices. 
A standalone Data Collection Device should always be configured as a Master unit. 
Redundant arrangements which feature automatic changeover and fallback between 
Data Collection Devices in the event of failure would normally be set to Master for both 
units, though earlier systems with manual fallback would require the duty Data 
Collection Device to be set as Master and the standby Data Collection Device as Slave.

Once all settings have been made, click on Apply to save the configuration.

14.2 Data Collection Device Configuration Step 2
The second part of the Data Collection Device Configuration tool allows the individual ports 
to be configured.

BA00390GEN_0222
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First select the desired Data Collection Device from the tree view.
The port configuration for the selected Data Collection Device will then be displayed. The 
number of ports listed will depend upon the Model of the Data Collection Device. In the 
example illustrated above of a Model 3500 Datacon, you will see that ports 1 and 4 are 
marked as Reserved, these being the Ethernet network port and Engineer's Terminal 
port respectively, and thus are not available for configuration.

Click on any of the editable fields to edit the configuration.
For each port which is to be used for communications, select the appropriate Driver 
from the drop-down list of available communications drivers. Some drivers utilise RS232 
communications, which is the default hardware fitted for each port. Other drivers may 
require dedicated interface hardware to be installed into the Data Collection Device in 
addition to selecting the correct driver.

Some drivers will enter a default set of parameters.

The Parameters entry specifies in order, the Baud Rate (communications speed), Parity, 
number of data bits, number of stop bits and any additional optional parameter necessary 
for correct operation of the driver. The items in the Parameters list should be separated by 
commas, but no spaces. Remember that the order or sequence of the parameters in the list 
is important.
Only certain distinct selections are permitted for each of the parameters:

• Baud Rate: 300, 600, 1200, 1800, 2400, 4800, 9600, 19200 or 38400 (bits per second)
• Parity: E (even), O (odd), N (none)
• Data Bits: 7 or 8
• Stop Bits: 1 or 2

e.g. 1200,O,7,1 is 1200 Baud, Odd Parity, 7 data bits, 1 Stop Bit.
The optional parameter will depend upon the type of driver. In the case of gauge / field 
device drivers the optional parameter allows the user to override the default number of 
communications retries used for that port. The default, which will be used if the optional 
parameter is omitted, is usually three.
In the case of host communication interfaces, the optional parameter usually specifies the 
Slave Address of the Data Collection Device.

Once all settings have been made, click on Apply to save the configuration.

14.3 Device Configuration
To launch the Device Configuration tool, select its entry from the Configuration menu.
The Default site node will always appear in the tree view, any configured sites will also 
be displayed as a top level site node in the tree view. Any configured tanks will be 
displayed a level below the site node, followed by any devices configured to a tank. 
E.g. Site Node → Tank Node → Device Node

1.
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The form displays the configuration settings of a selected node. The Default site node 
configuration cannot be edited or deleted.

To add a new site to the tree view, click on the Add Site button.
A dialog box will be displayed prompting for a site name.

Once the new site has been added, select the site node and the editing features will be 
available on the editing panel.

To delete an existing site, click on the Delete Site button.
Sites can only be deleted if all connected tanks have also been removed from the site.

To clear a site of all connected tanks, right click on the site and click Clear Site.

To edit the configuration of an existing site, click the site node you wish to edit and the 
editing features will be available on the editing panel.

Make the modifications and save the changes.

14.3.1 Adding a new tank
To add a new tank to the tree view, right click on the site node you wish to add the tank 
to, then click Add Tank.
The following dialog box will display:
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The tank prefix field is a template which the application uses to add multiple tanks at once, 
alternatively if the Add Multiple Tanks check box is not checked, a single tank will be added 
with the name entered in the tank prefix. When adding multiple tanks, the tank prefix 
follows a specific syntax; any text characters in the field will be added to the prefix of the 
tank name. Any 0’s indicate the trailing zeros after the prefix. E.g., if the tank prefix was 
‘TK000’ and 10 tanks were added, they would be given the following names:

• TK001
• TK002
• TK003
• TK004
• TK005
• TK006
• TK007
• TK008
• TK009
• TK010

Tank Start Count and Number Of Tanks fields will only be available if Add Multiple Tanks 
is checked. The tank start count field states the number at which the new added tanks will 
start at. E.g. if the tank start count was 10 and 5 new tanks were added, the new tanks would 
start at 10 and count up 5 to 14.
Number of tanks states the number of tanks that will be added. A maximum of 100 tanks 
can be added at once, and 5000 tanks can be added in total.

Select the device type and duty for the tank.

Click OK to add the tank.

Alternatively, a new tank may be added to the list by copying an existing one. In this 
case, right click on the tank you wish to copy and click Copy. Multiple tanks can also be 
copied by selecting tanks from the tree view by holding down the ‘Control’ key and 
clicking individual tanks, or holding down the ‘Shift’ key and selecting multiple tanks 
using the arrow keys. Once tanks have been copied, right click on the site you wish to 
paste the tanks and click Paste, this will produce new tank nodes in the tree view, 
settings will replicate those of the tank from which the copy was made. Any gauges 
attached to the copied tank will also be copied and pasted.
To delete an existing tank, right click on the tank you wish to delete.
Click Delete.
Alternatively, selecting the tank and pressing the ‘Delete’ key will also delete the tank. 
Multiple tanks can also be deleted by selecting tanks from the tree view by holding down 
the ‘Control’ key and clicking individual tanks, or holding down the ‘Shift’ key and 
selecting multiple tanks using the arrow keys. Doing so will remove the corresponding 
tanks from the system as well as any devices attached.

To edit the configuration of an existing tank, select the tank node from the tree view and 
the fields will appear on the editing panel to the right.

Make the modifications and save the changes.

Each manufacturers device has different basic requirements for configuration. Knowledge of 
the different makes and models of devices is useful at this stage although not essential. The 
following instructions do not provide an exhaustive guide as to the valid options and 
selections for each type of device; rather instruction is given as to the way in which the 
information is entered into the system. Application validation features, notes and 
manufacturer's literature should be consulted for further information.

2.
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The form displays the different configuration settings of one device at a time: Common 
Configuration, Dimensions, Device Configuration and Auxiliary.

14.3.2 Adding a new device
To add a new device to the tree view, right click on the tank node you wish to add the 
device to, then click Add Device.
The following dialog box will display:

BA00390GEN_0100

Select the device type and duty.

Click OK to add the devices.

Alternatively, a new device may be added to the list by copying an existing one. In this 
case, right click on the device you wish to copy and click Copy. Multiple devices can also 
be copied by selecting device nodes from the tree view by holding down the ‘Control’ key 
and clicking individual devices, or holding down the ‘Shift’ key and selecting multiple 
devices using the arrow keys. Once devices have been copied, right click on the tank you 
wish to paste the devices and click Paste, this will produce new device nodes in the tree 
view, settings will replicate those of the device from which the copy was made.
To delete an existing device, right click on the device you wish to delete.

1.

2.

3.

4.
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Click Delete.
Alternatively, selecting the device and pressing the ‘Delete’ key will also delete the 
device. Multiple devices can also be deleted by selecting devices from the tree view by 
holding down the ‘Control’ key and clicking individual devices, or holding down the 
‘Shift’ key and selecting multiple devices using the arrow keys. Doing so will remove the 
corresponding devices from the system.

To edit the configuration of an existing device, select the device node from the tree view 
and the fields will appear on the editing panel to the right.

Make the modifications and save the changes.

When configuring a new device, it is recommended to complete the applicable data entry 
fields in the order they appear starting from Common Configuration working down to 
Auxiliary fields. Certain selections, e.g. Device Type, will affect the data entry requirements.

If the system uses direct communications with the gauges/field devices, the Master 
Data Collection Device Name and Slave Data Collection Device Name should be left 
blank. 
Otherwise, the name of the Data Collection Device to which the device is connected 
should be selected from the Master Data Collection Device Name list. 
If the system includes redundant Data Collection Devices, also select the Slave Data 
Collection Device Name from its list.

Device Type
The Device Typ drop-down list provides a selection of gauges and field devices of various 
models from various manufacturers. Select the one that matches or most closely resembles 
the actual gauge or device which will be connected.

Tank ID
The Tank ID entry links the gauge to a tank. Typically, each gauge will be associated with a 
unique tank, though there are cases where there will be a number of gauges fitted to the 
same tank and thus share a common Tank ID.

Data Collection Device Port Address
Data Collection Device Port Address is the number of the Data Collection Device port to 
which the gauge will be connected. Ignore this if the system uses direct communication 
between PC and device with no Data Collection Device.

Comm Port
Comm Port is the number of the port on the PC to which the Data Collection Device or 
the device itself is connected. For redundant systems, also specify the Backup Comm 
Port.

To put a Tank into simulation mode set the Comm Port to 99. The data for the tank will 
then be derived from the integrated tank simulator normally used for demonstrations, 
presentations and training.

CIU Address and Gauge/Device Address
The selections for CIU Address and Gauge/Device Address (or their corresponding names 
in the case of other types of gauges/devices) will depend upon not only the Device Type but 
also the way in which the device is connected. Typically, the CIU Address is the address of 
the device which the system or Data Collection Device communicates with, and the Gauge/
Device Address is the address, register or location from which the level may be read. The 
data format of the entries (e.g. decimal/hexadecimal) will also be determined by the Device 
Type. The following examples should illustrate the typical scenarios:

5.

6.

7.
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Enraf systems may include a CIU or may communicate directly with the gauges themselves. 
The level is read from the gauge using one of a number of specific requests. The CIU Address 
will be that of the actual CIU (if present) as a decimal number in the range "0" to "9", and the 
Gauge Address will be the Transmission Address of the gauge as a decimal number in the 
range "0" to "99".

SAAB systems may also include an interface unit; this time called a FIU, or may 
communicate directly with the gauges. Here, the level is read from one of a number of 
different Modbus registers within the FIU (if present) or the gauge. The FIU Address will be 
the Modbus Slave Address of the FIU (where present) or the gauge (direct communications 
without FIU) as a hexadecimal number in the range "01" to "F7". The Gauge Address is the 
Modbus Register Address from which the level will be read as a hexadecimal number in the 
range "0" to "FFFF". Other types of gauge that use the Modbus protocol will also follow this 
same pattern.

Whessoe systems fall into two basic types, the older (WM500) which uses a 
communications Outstation. The Outstation Address is specified as a decimal number in 
the range "0" to "15", and the Gauge Address specifies the outstation channel from which the 
level is read as a decimal number in the range "0" to "15". Later Whessoe systems (WM550) 
do not use an outstation; communication is directly to the gauge. In this case only the Gauge 
Address is required and is specified as a decimal number in the range "0" to "31".

Motherwell systems only use the Gauge Address setting, whether as an index number when 
requesting level from a communications rack (MCS4000) or as a field address when 
communicating directly with later type gauges (MCS2800). The Gauge Address is a 
hexadecimal number in the range "0" to "FF".

Devices of other manufacturers/types will generally fall into one of the above categories. If 
in doubt, consult the gauge manufacturer's literature and the Data Collection Device 
configuration application notes.

Data Collection Device Index
In the case of systems that use the Data Collection Device for field communications, the Data 
Collection Device Index is the address or "position" within the internal configuration 
database of the Data Collection Device where this device will reside. The positions are 
addressed from 0 to 255. Each device must have a unique Data Collection Device Index 
within the Data Collection Device. If Data Collection Devices are not used then any unique 
number may be entered into this field, as it is not used by the tank gauging system. This field 
should not be left blank.

Type Of Instrument
The Type Of Instrument and Type Of Record selections are only required for certain device 
types which offer different protocols or requests for level. For example, Enraf; where the 
Type Of Instrument specifies the protocol ("A" = GPP, "B" = GPU, etc.) and the Type Of Record 
specifies the request used to read level from the device (typically "B").

Multi-Gauges
If the device is one of a number of devices all fitted to the same tank, select Multi-Gauges. 
An additional frame will be displayed where the Device Duty should be selected. There 
should be only one Primary and once Secondary Device on each tank, the others should be 
backup devices, generic devices or used for other specific duties as listed.

Backup CIU
Systems which feature redundant CIUs should have Backup CIU Available selected. An 
additional frame will be displayed. Set the Backup CIU Address and Backup CIU Mode 
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appropriate, depending upon whether changeover is automatically performed or manually 
requested.

Average Temp. Fitted
Certain devices which are provided with multi-element averaging/multi-spot temperature 
measurement may allow the individual element temperatures to be read via the 
communications. If this feature is available and desired, select Average Temp. Fitted.

Flow Rate
To alter the response of the level flow rate calculation, and consequently the volume and 
mass/weight flow rates, two parameters are available for user configuration. The Flow Rate 
Damping factor is a measure of how much of the current instantaneous flow rate reading is 
incorporated into the filtered value, as a percentage. Increasing the figure increases the 
responsiveness of the resulting flow rates but reduces the effective damping. The Flow Rate 
Integration factor is a time in seconds, up to 240 seconds maximum (four minutes), used to 
increase the effect of damping where the level readings/flow rate calculations are performed 
at shorter intervals depending upon the number of gauges present on the particular 
communications port. In most cases the defaults are acceptable.

Background Scan/Auxiliary
The Background Scan/Auxiliary settings are used to read data parameters other than 
Product Level from the device at lesser frequency than the level. Product Level is the primary 
data item and is the default item polled from the device by the system. Polls for other items 
may be inserted periodically by the system dependent upon the settings of the Background 
Scan / Auxiliary items. Where used, Auxiliary 1 is assumed to be for Product (Average) 
Temperature, and is typically polled at half to quarter of the rate of Product Level. The other 
items Auxiliary 2 to Auxiliary 16 are inserted into the normal polling sequence at a default 
of three minute intervals. The background scan interval can be modified in the DCC 
Configuration module. The Auxiliary scans are typically be used to read Free Water Level, 
Density, Vapour Pressure, Vapour Temperature, etc. The format of the Auxiliary entry will 
depend upon the device type e.g. Enraf Auxiliaries use the following screen:

BA00390GEN_0101

All auxiliary settings can be viewed in the ‘classic’ style (without specific validation) by 
clicking the ‘Classic Auxiliary View’ icon:
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By selecting the "Classic" view, there is no validation performed and therefore more 
chance of a device being configured incorrectly.

For Enraf gauges, the Auxiliary entry is formed of the two digit decimal Transmission 
Address of the device from which the item is to be read (usually the same as the Gauge 
Address) in the range "00" to "99" including any leading zeros, followed by the one or two 
character alphanumeric code of the data item as per the Enraf GPU protocol. A single letter 
appended to the address will be interpreted as a Type Of Request, whereas a two character 
code will be interpreted as a Data Item identifier for a Z Record request. As in the example 
displayed above, Auxiliary 1 is set to request a C Record (Product Temperature), Auxiliary 2 
will request Data Item YB (Free Water Level) and Auxiliary 3 will request Data Item SC 
(Average Servo Density). All of these auxiliary items will be requested from address 04, that 
being the same as the Gauge Address.

For SAAB gauges, the Auxiliary items should be set to the Modbus Register Address of the 
desired data value as a four digit hexadecimal number in the range "0000" to "FFFF", including 
any leading zeros.

Where devices provide Product Temperature in a combined response along with Product 
Level, as is the case with Whessoe and Motherwell gauges for example, there is no need to 
set the Auxiliary 1 item to specifically request temperature.

The system and the Data Collection Device will assume that any values read from the 
gauges/field devices are in Metric units unless the system is able to determine the 
measurement units of the gauge/field device automatically via the communications. If this 
is the case, the Change Dimensions entries should be left in their default setting of "AUTO". 
With certain gauges, the system must be configured specifically to match the measurement 
units of the data from the gauge by selecting the appropriate units of measure from the 
drop-down lists.

Once all settings for the gauge have been configured, always remember to apply the settings 
by clicking on the Apply button. Note that this saves the configuration settings to the 
database, but does not in itself alter the configuration of any Data Collection Device present 
in the system. 
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14.3.3 ModbusTG Gauges
ModbusTG gauges are assigned to ModbusTG interface ports and are used to poll for tank 
data from slave devices using the standard Modbus protocol. These slaves may be PLCs, 
Remote I/O units or gauges equipped with a Modbus interface.
ModbusTG gauges are often used as Auxiliary gauges, to bring in background data items for 
primary gauges. See section on "Multi Gauges" for more details, → ä 123.
ModbusTG gauges may require more configuration than other gauges due to their generic 
nature. There are two steps to configuring a gauge:

Configure gauges on the port with a basic Modbus map, using the standard Device 
Configuration screens.

If required, configure an advanced Modbus register map in an XML config file.

ModbusTG Basic Map
Gauges must be configured to use the ModbusTG driver. This can be done in the normal way 
using the standard Device Configuration screens.

BA00390GEN_0103

A very basic modbus map may be defined for the gauge using the following fields:
• Device Type

The gauge must be set to Modbus TG. 
• Device Address

The modbus RTU address of the slave device.
• Level Register

The Modbus address of the register that returns Product Level. This starts from zero and 
should not include the Modbus function code offset. For example, a Modbus register full 
address of 40001 should be entered as 0 (and Modbus Type should be set to 3).

This parameter is not used for Auxiliary duty gauges.

• Data Type
Must be set to Short.

• Modbus Function
The Modbus function code to be used for the Level register (and Temperature if used) i.e. 
Coil, Input Status, Holding Register, Input Register.

• Auxiliary 1 (Temperature Register)

1.

2.
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An optional field that defines the Modbus address of the register that returns the 
Temperature.

This will set the ModbusTG to poll for the level data (for non-Auxiliary duty gauges only) 
using a standard set of decoding parameters:
• Input range: 0 - 32000 in millimeters.
• Encoded as a two byte Short with Little Endian format.
• A value outside the range 0 - 32000 will be decoded as a bad value.

If the Auxiliary 1 field has been entered then the ModbusTG will poll for temperature data 
using a standard set of decoding parameters: 
• Input range +- 3200 Degrees C sent times 10, i.e. +32 DegC encoded as 320.
• Encoded as a two byte Short with Little Endian format.
• A value of 8000 Hex will be decoded as an illegal value.

If the above encoded format for level (and temperature if enabled) is supported by the 
slave device and no other data (e.g. density etc.) is required, then no other 
configuration is needed for the ModbusTG driver.
Level will never be polled for Auxiliary duty gauges.
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ModbusTG Advanced Map
If the very basic Modbus map defined when the gauges are added to the system is not 
enough then it may be overridden with a much more advanced map, defined in a separate 
XML format file. This allows more flexible encoding of data to be defined and also permits a 
much greater range of data parameters to be polled for.
A configuration tool, "Modbus Config.exe", is available to allow the user to configure the XML 
file. This is located in the standard installation directory.
The user may also directly edit the configuration file and details of how to do this are 
included in this document. However it is recommended that direct editing should only be 
used in extreme circumstances, as it may lead to an invalid file structure.

The advanced map consists of a set of Interfaces, each of which may have:
• A set of default parameter details which apply to ALL gauges on the interface 
• A set of gauge parameter details which apply only to the selected gauge 

All parameters are optional and need not be defined in the map, as they will default to a set 
of standard values (defined later in this document, → ä 116).

Modbus Configuration Tool

To configure the advanced Modbus map, proceed as follows:

Select the menu option Configuration → DCC Host Configuration.

The DCC Host Configuration page allows advanced configuration of certain host drivers, 
including the ModbusTG driver.
A list of all COM ports that have drivers that require advanced configuration will be shown 
in the left hand panel. This will include all ModbusTG interfaces that have at least one 
ModbusTG gauge assigned to them.

If no ModbusTG interfaces appear in the list, then ensure that all ModbusTG 
interfaces have been defined (com ports in DCC hosts) and at least one gauge of type 
ModbusTG has been assigned to each interface (com port).

The list of COM ports can be expanded to display all gauges assigned to that port.

BA00390GEN_0223

1.
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Each Com Port will have a list of all tanks assigned (including the gauge duty, i.e. Primary, 
Secondary etc.) and also a section called Defaults.
The Modbus fields that are to be polled for each gauge will be displayed beneath the gauge 
they apply to. These fields include product level, temperature, pressure etc. and will only be 
polled by the ModbusTG interface if they are added to the configuration in this tool.

For non Auxiliary duty gauges, Product Level will always be polled for, even if not 
configured here – see section on ModbusTG Basic Map (→ ä 113).

The Defaults section allows the user to configure Modbus field definitions that will be added 
to ALL gauges on this ModbusTG interface. If a field is added to the Defaults section it will 
be polled by a gauge even if the field has not been added to the individual gauge.
Each gauge can be configured with Modbus field definitions that apply only to that gauge. 
All field data entered for an individual gauge will override data entered in the Defaults 
section. Thus data common to all gauges may be entered in the Defaults section, and then 
individually tailored for each gauge as required.

Adding a Modbus Field
To add a new Modbus field to a gauge or the Defaults, proceed as follows:

Right click on the field.

Select Add from the pop-up menu.

Select the field from the Add Modbus Item dialog displayed.

BA00390GEN_0105

The new field will be displayed in the left hand panel.

Deleting a Modbus Field
To delete a Modbus field, proceed as follows:

Right click on the field.

Select Delete from the pop-up menu.

Editing a Modbus Field
To edit a Modbus field, proceed as follows:

Right click on the field.

Select Edit from the pop-up menu.

This will display the current set of definitions for the field in a window in the right hand 
panel. Multiple Modbus fields may be edited at the same time.

1.
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The parameters are optional and are only used if the left hand box is ticked. Any parameters 
not ticked will use the default values, defined later in this section.
The range of parameters displayed will depend on the data field selected.

Common to most modbus fields are the following parameters:
• Address

The modbus address of the register or coil, from zero.
• Function

The modbus function type i.e. Holding Register, Coil etc.
• DataType

The format of the data to be requested. May be one of the following:
– Signed Char (range -127 to +127 using 1 register)
– Unsigned Char (range 0 to 255 using 1 register)
– Short (range -32767 to +32767 using 1 register)
– Unsigned Short (range 0 to 65535 using 1 register)
– Integer (range -2147483647 to 2147483647 using 2 registers)
– Unsigned Integer (range 0 to 4294967295 using 2 registers)
– Float (using 2 registers)
– Double (using 4 registers)

• Data Order
The byte order of the data, may be one the following:
– Little Endian (Standard format for MS Windows based systems)
– Big Endian
– Little Logical
– Big Logical (often used by DCS systems for Float datatypes)

• Raw Min and Raw Max
The raw data range. Used in scaling data (see below) and also if the value is outside the 
raw limits then the value will be set to illegal, i.e. DN04

• Scaled Min and Scaled Max
The scaled data range. The Scaled value must be converted to the default units used within 
the TankGauging database, ( Level=mm, Temperature=DegC, Density=Kg/l, 
Pressure=BarA ). For status fields it is recommended that these should be set to the same 
as the raw limits. Data will be converted using the formula:

ScaledValue = (( RawValue - RawMin ) / ( RawMax - RawMin ))  *  ( ScaledMax - 
ScaledMin ) + ScaledMin 



Data Collection Device & Device Configuration Tankvision Professional NXA85 - System Configuration

118 Endress+Hauser

• Scaled Offset
An optional offset to be applied to the scaled value, in the database units for the data type 
( Level=mm , Temperature=DegC , Density=Kg/l , Pressure=BarA )

• Damping
Not used for status values. A percentage value that is used to damp values that fluctuate 
rapidly. This field should be entered in the range 0 -100, with 0 and 100 being treated the 
same as NO damping. Formula used is:

DampedValue = OldValue + ((NewValue - OldValue) * damping / 100)

Fields for Status parameters
If the modbus field is a Status (i.e. Base Pressure Status, Product level Status etc) then the 
following parameters will also be available:
• Status Type

Only used for status fields. Defines the test used on the input value to determine if the field 
is valid i.e. Good. If the test is true for illegal or bad then the field is Invalid and will be set 
to DN04. May be one of the following: 
– None
– One illegal value
– One good value
– Bits set good
– Bits set bad

• Status Test Value
Only used for status fields. Defines the value used to test any special case for validity, 
depending on the value of statustype. If statustype is 3 or 4 then any of the bits in this 
value will be tested.

Fields for Alarm parameters

If the modbus field is an Alarm (i.e. Level High High , Temp High etc ) then the following 
parameters will also be available:
• Alarm Type

Defines the test used on the input value to determine if the alarm is active. May be one of 
the following:
– None
– Equals Value Sets Alarm
– Bits set Alarm (i.e. Any of the bits in Alarm Test VAlue will set the alarm)
– Bits Cleared Set Alarm
– Greater Than Value Sets Alarm
– Less Than Value Sets Alarm

• Alarm Test Value
The value used to test the alarm activation status of the incoming data.

• Hysteresis
The value used determine when alarm is cleared. Only used for types "Greater Than Value 
Sets Alarm" and "Less Than Value Sets Alarm".

Default values

Any Field parameters not defined for an individual gauge will use those defined in the 
Defaults section. If the Field parameter has not been defined in the Defaults section then the 
following defaults will be used by the ModbusTG interface when polling for data:
• slaveaddress = Device No. entered in Device Configuration screen (→ ä 103)
• address = 0
• function = 4
• dataorder = Short
• rawmin = 0
• rawmax = 32000
• scaledmin = 0
• scaledmin = 32000
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• statustype = 1 (status fields only)
• statusvalue = 8000 hex (status fields only)
• damping = 0 (i.e. not used) (value fields only)

For Product Level the default values will be those set in the Gauge Configuration 
screens. If Product Temperature has been defined in the Gauge Configuration screens 
then those defaults will be used. (→ ä 25)
The Modbus PLC address for the field will be the Device Address field entered in the 
Gauge Configuration screen.
Click OK in the edit box to save the parameters for the Modbus field.

Saving the Modbus Map

To save the new modbus configuration to the Modbus xml file, proceed as follows
Close the DCC Host Configuration tool.
If any changes have been made then the follwoing dialog will be displayed:
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Click Yes to save the data and automatically force the DCCHost service to reload the new 
modbus map for any ModbusTG interfaces.

ModbusTG Field Definitions
The Defaults section and any Gauge node can contain a set of modbus fields which will be 
polled by the ModbusTG.
Each field node can contain one or more attributes which define what the field is and how 
the ModbusTG driver will decode the incoming data when polled.
The ModbusTG interface is specifically designed to poll for tank gauge data and thus data 
fields are polled in a defined way.

There are three basic types of fields in the ModbusTG driver, which operate in slightly 
different ways. The fields are:
• Data Fields - Used to get the actual value of a data item, such as level, temperature etc.
• Status Field - Optional, used to get the validity of an associated data item. A status field 

is denoted by name ending in Status. 
• Alarm Field - Used to bring in an alarm. An alarm field is denoted by Alarm in name of 

field.

Fields polled at high priority

Certain fields are polled at high priority, and will always be polled regardless of whether they 
have been added to the advanced Modbus Map or not. These are:
• Product Level 
• Product Level Status 

The above fields will NEVER be polled for an auxiliary duty gauge.

The following fields will be polled at high priority if they have been defined in the advanced 
Modbus Map:
• Product Temperature
• Product Temperature Status
• DensityHigh Alarm

1.

1.

2.
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• DensityLow Alarm
• LevelHigh Alarm
• LevelHighHigh Alarm
• LevelLow Alarm
• LevelLowLow Alarm
• TempHigh Alarm
• TempLow Alarm
• GaugeStatus

Fields polled in background scans

Other fields are only polled on background scans, and only if they have been defined in the 
Modbus Advanced Map. The background scan period is defined per interface and defaults 
to three minutes. These fields include:
• BasePressure
• BasePressureStatus
• FreeWaterLevel
• FreeWaterLevelStatus
• Density
• DensityStatus
• ObservedTemperature
• ObservedTemperatureStatus
• ProductPressure
• ProductPressureStatus
• VapourPressure
• VapourPressureStatus
• VapourTemperature
• VapourTemperatureStatus
• ElementTemperature1 - 16 
• ElementTemperature1 - 16Status

Validity of fields

From the above list it can be seen that most fields are in pairs, with a value field and a status 
field. Thus the Product Level field has a corresponding Product Level Status field etc.

The validity of a value field is determined by the following:
• If the incoming data is outside the raw scaling limits then the value will be set to illegal 

status i.e. DN04.
• If a status field has been added (i.e. level status added as well as level value) then it 

determines the status of the value.

A status field may be added to the map in addition to the value field. These are generally 
used in cases where the status of the data is set in a separate Modbus Field (coil or register). 
However the status field may be set to the same Modbus Address as the value.

For status fields the are an extra set of parameters that determine how to decode the status. 
They work in the following manner:
• If the status is outside the raw scaling limits then the value will be set to illegal status i.e. 

DN04.
• If the status is within the raw limits then the Status Type parameter will be used to 

determine how to test for illegal status using the Status Test Value.

Many Modbus Maps implemented by slave devices do not have separate status registers (or 
bits ) but instead set the value to some error figure (i.e. full scale etc.). In this case the status 
field should be set to the same Modbus Address and parameters of the value field (i.e. same 
raw scaling parameters).
Alarm fields must have the Status Type and Status Test Values fields configured. They are 
used to test the incoming data to check whether the alarm is active or inactive. In this case 
if the data tests Good then the alarm is active, if it tests Bad then the alarm is inactive.
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ModbusTG User Defined Alarms
User Defined Alarms are a set of alarms generated by certain gauge type, which the user may 
configure the text to be displayed when the alarm is activated and cleared. There are eight 
such alarms per gauge:

• User Defined Alarm 1
• User Defined Alarm 2
• User Defined Alarm 3
• User Defined Alarm 4
• User Defined Alarm 5
• User Defined Alarm 6
• User Defined Alarm 7
• User Defined Alarm 8

The alarms are available in the database for all gauge types, however whether they can be 
used depends on the physical gauge type. In fact only the ModbusTG gauge type running on 
the ModbusTG direct interface currently supports the use of User Defined Alarms.
The text and severity for each alarm may be configured. See section 5.5 for details on how 
to do this.

Polling for User Defined Alarms

To configure a ModbusTG gauge to poll for one of the eight User Defined Alarms, proceed 
as follows:

Select the menu option Configuration → DCC Host Configuration.

Add the point to the required gauge.
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These may be configured to read individual coils.

1.

2.



Data Collection Device & Device Configuration Tankvision Professional NXA85 - System Configuration

122 Endress+Hauser

Example 1
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In the above configuration, User Defined Alarm 1 will be generated from an Input Status coil 
at address 1.

• The Alarm Type field is used to set the activation of the alarm.
• The Alarm Test Value will be used to test the incoming data to see whether the alarm is 

active.

Therefore in this case Alarm Type is set to Bits Set Alarm and the test value is one. So if a 
value of 1 is received then the alarm will be activated, any other value will clear the alarm. 
The incoming value is a coil therefore it will be either 1 or 0.
User defined alarms may also be configured to read individual bits within a bit-mapped 
register. In that case the Data Type would be set to unsigned short, and the Status Type will 
defined the bits to be tested.
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Example 2
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In the above configuration, User Defined Alarm 2 will be generated from Bit 1 of an Input 
Register at address 3.

14.3.4 Multi Gauges
Tanks may be fitted with more than one gauge.
To configure multiple gauges per Tank, each gauge must be assigned a duty for the tank.

The Device Duty types available are:
• Primary
• Secondary
• Backup
• Densitometer
• Auxiliary
• Backup Densitometer
• Generic Device

These define how the gauge will be treated in the various operator displays.

Device Duty Configuration
To configure multiple gauges per tank carry out the following in the Device Configuration 
screen:

Add multiple devices onto a tank using the right click context menu.

Select the appropriate gauge duty from the Common Configuration panel.
1.

2.
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For multi-gauge tanks configuration data entered for the tank will be saved for ALL the 
gauges on that tank. This applies to data entered in the following screens:

• Tank Characteristics
• Alarm Configuration 
• Tank Capacity Tables

This means that when a programmable alarm is triggered on a multi-gauge tank, an alarm 
event will be generated for each gauge on the tank.
The exception to the above is the Manual Data screen. Data entered in that screen is per 
individual gauge, not the tank.

Primary Gauge
One gauge must be configured as the primary duty gauge and there can only be one per tank. 
This is the gauge that will be used to display the tank data in most of the operator screens.
If a Densitometer duty gauge is also present on a tank then the Product Density and 
Observed Temperature will be automatically be copied from the Densitometer to the 
primary.
If an Auxiliary duty gauge is present on a tank then any background parameters that are not 
available in the primary will be automatically transferred from the auxiliary gauge.

Secondary Gauge
If more than one level gauge is required on a tank then set the second gauge to be Secondary 
duty. It will not be displayed in the inventory screens but may be accessed via modbus and 
OPC interfaces.
The secondary gauge will not normally be displayed on any screens.
Its main use is for the Difference alarm. When this alarm is enabled for a tank, it monitors 
the Primary and Secondary gauge levels and generates an alarm if they differ by more than 
the allowable tolerance.
Only one secondary gauge should be configured.

Backup Gauge
Any other level gauges on a tank should be configured as Backup duty.
They will not be displayed in the inventory screens (except for LNG systems) but may be 
accessed via modbus and OPC interfaces.
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Densitometer Gauge
This duty is only required for LNG tanks and is used for devices such as the Scientific 
Instruments 6280/6290, although any gauge capable of carrying out profiles may be 
configured as a densitometer.
Its main purpose is to carry out profiles and calculate the product density, which is then 
automatically transferred to the primary gauge for volume/mass calculations.

Auxiliary Gauge
An auxiliary gauge is different from all other gauge duties, and is not treated as a separate 
gauge on its own, rather it is used to retrieve background scan parameters (pressures, 
temperatures, water bottom etc) from a separate device and store them in the Primary 
gauge.
An auxiliary gauge will not poll for level, generate alarms or be displayed in the operator 
screens. It is typically used on a ModbusTG interface to access parameters from devices such 
as pressure transducers. All data retrieved from an auxiliary gauge will be transferred to the 
Primary gauge and used in the volume calculations.

Parameters on an auxiliary gauge will only be polled on the background scan and include:
• Product Temperature
• Vapour Temperature 
• Density
• All Pressures
• Multi-Element temperatures (not transferred to Primary)
• Skin Temperatures (not transferred to Primary)
• Water bottom
• Gauge Alarms

It is important to consider the background scan rate of any interface polling for auxiliary 
tanks. This will determine the rate of update for the data to be transferred to the primary 
gauge. If the interface is only polling for auxiliary gauges then it is recommended that the 
background scan rate is reduced from the default (default 180 seconds, minimum 
10 seconds).

Backup Densitometer Gauge
Any other densitometer gauges on a tank should be configured as Backup Densitometer 
duty.

Generic Device
Any devices other than gauges on a tank should be configured as Generic Device duty.

14.4 COM View
The COM View is an additional feature added to easily see which devices are connected on 
each "In Use" COM port. To access the COM View, click the COM View button on the device 
configuration screen.
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The simulator node will always appear and cannot be deleted. Any COM ports configured to 
‘In Use’ within DCC Configuration will also be displayed as COM nodes. Any devices 
configured to the COM ports will be displayed as child nodes of the parent COM node. 
Connected devices can be configured within this screen, by selecting the device and editing 
the fields on the panel to the right.
Clicking on a COM port node displays the configuration settings of the COM port, these 
cannot be edited within the application, but can be edited within the DCC Configuration 
application, which can be launched by clicking the Launch DCC Config button. If new ports 
are configured, they will not appear in the tree view until the screen is refreshed by clicking 
the Refresh View button.
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15 Tanks by User
This function provides an administrator with the ability to configure which tanks a user login 
can view.
This is quite useful on larger multi-user systems where tank operations are split between 
different users, and a user may be responsible for looking after a specific set of tanks.

Select the Tanks By User option from the Admin menu.
The Tanks By User display will be loaded.

BA00390GEN_0228

This display comprises two list boxes. One list containing the currently configured users and 
the other the full list of tanks with the tanks currently assigned to the selected user 
highlighted.

15.1 Setting Tanks a User Can View
To set the tanks a user can view, proceed as follows:

Select the user from the list.
Any tanks currently allocated to that user will be highlighted. Highlight the tanks in the 
tanks list that the selected user is able to view.

Click the OK button to save the changes. Repeat this for each user.

To exit the screen without saving the changes click the Cancel button.

For Tanks by User to work Login Enabled must be selected in Security Settings.

1.

1.

2.

3.
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16 Trending Configuration
Trending configuration is done on a server or standalone station. It is accessed via the Service 
Manager in the Windows system tray. The display is a multi-tabbed dialog as shown below.

16.1 General Tab
This contains configuration options relating to the trending service and housekeeping of the 
trend files.
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Trend File Location
A directory where the trend files will be stored. This location is relative to the Application 
directory.

Update Interval
The interval at which the tank data is checked to see if it has changed.

TCP Port
The TCP port to be used by clients to communicate with the trending service.

Automatically Delete Historical Trend Files
If this option is checked historical trend files will be deleted after the time specified below.

Delete Trend Files After
The age the files need to be before they are deleted, if this feature is enabled.

Raise Alarm When Disk Space is Getting Low
If this option is checked an alarm will be raised through the events subsystem when the 
available disk space falls below the defined threshold.
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Raise Alarm When Available Disk Space Falls Below
The available disk space below which an alarm is to be raised.

16.2 Threshold Tab
The Threshold tab allows the sensitivity of the trending to be modified. The new value of a 
parameter will only be written to the trend file when the change in value (since it was last 
written to the trend file) is greater than the threshold defined for that field type.
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The threshold values can be overridden for individual tanks to allow for the different 
behavior of different products and/or tank shapes. To override the threshold values for a 
tank click on the Add button and select the tank from the list of tanks displayed. The tank 
will then appear in the list of tanks. Ensure that the tank is highlighted and then amend the 
threshold values.
Similarly to remove the override for the tank ensure that it is highlighted in the list and then 
click on the Remove button.
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16.3 Filter Tab
The Filter tab allows the data to be trended for each tank/gauge to be unique. By default all 
tanks, gauge duties and fields are trended.
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Only Trend Selected Tanks
If this option is checked, only the data for the tanks highlighted in the list of tanks will be 
trended. Otherwise the data for all of the tanks will be trended.

Trend Primary
If this option is checked, the data for the primary gauges will be trended.

Trend Secondary
This option will only be visible if one or more tanks in the system has a secondary gauge 
configured. If this option is checked, the data for the secondary gauges will be trended.

Trend Backup
This option will only be visible if one or more tanks in the system has a backup gauge 
configured. If this option is checked, the data for the backup gauges will be trended.

Trend Densitometer
This option will only be visible if one or more tanks in the system has a densitometer 
configured. If this option is checked, the data for the densitometers will be trended.

Only Trend Selected Fields
If this option is checked, only the data for the fields highlighted in the list of fields will be 
trended. Otherwise all the fields in the list will be trended.
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16.4 Advanced Filter
The Advanced Filter tab of the trending configuration screen allows trending options to be 
set for element temperatures and skin temperatures (if appropriate). By default, element 
temperatures and skin temperatures are not trended.
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To set the element temperatures and/or skin temperatures to be trended on all gauges click 
on the click here hyperlink in the description. This will display the following screen:
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Highlight the element temperatures and skin temperatures to be trended and click the OK 
button. Note that this will overwrite the existing selected element temperatures and skin 
temperatures for all gauges.
To set the element temperatures and skin temperatures to be trended for an individual tank, 
double-click the tank in the tanks list. If the tank has multiple gauges, double-click the gauge 
for which the element temperature and skin temperatures are to be trended. If the element 
temperatures can be trended for a gauge, the entry Element Temperatures will appear 
under the gauge. Similarly if the skin temperatures can be trended for a gauge, the entry 
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Skin Temperatures will appear under the gauge. Select either Element Temperatures or 
Skin Temperatures and the list on the right hand side of the screen will be populated with 
the element temperatures or skin temperatures respectively. The temperatures to be 
trended will be highlighted. To modify the temperatures to be trended, highlight the 
temperatures to be trended.

16.5 Monitoring Alarms
The Monitoring Alarms tab of the trending configuration screen is used to configure and 
Enable/Disable the various trending alarms.
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General Settings
• Trend process poll period - The frequency, in seconds, that the trend service is polled to 

check the status of the alarm conditions.
• Trend process system startup hold-off - The delay, in seconds, after the system starts to 

allow the Trend service to stabilize. No alarms are raised during this time.

Not Running
If the Trending Service is not running no trend data will be generated. If enabled a "Trending 
Service not running" alarm will be raised in the Alarm Event Viewer. The following items are 
configurable:

• Enable - If this option is checked an alarm will be raised through the events subsystem if 
the Trending service stops running for the specified time (Poll period × Absence Count). If 
this option is not checked none of the alarms will be enabled and it will not be possible to 
configure any "count" or "hysteresis" values.

• Absence Count – Use this option to set the number of successive polls that must not detect 
that the trending service is running before an alarm is raised.

• Absence Hysteresis - Use this option to set the number of successive polls that must 
detect a running trending service before an alarm is cleared.

Not Responding
If the Trending Service stops responding to requests there will be a loss of "Real Time" 
trending data, "Historic" trend data may still be generated. If enabled a "Trending Service not 
responding" alarm will be raised in the Alarm Event Viewer. The following items are 
configurable:
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• Enable - If this option is checked an alarm will be raised through the events subsystem if 
the Trending service stops running for the specified time
(Poll period × No Response Count).

• No Response Count - Use this option to set the number of successive polls that must not 
detect a response from the trending service before an alarm is raised.

• No Response Hysteresis - Use this option to set the number of successive polls that must 
detect a response from the trending service before an alarm is cleared.

Not Recording
If the Trending Service stops recording there will be a loss of "Historic" trend data, "Real Time" 
trending data may still be available. If enabled a "Trending Service not recording" alarm will 
be raised in the Alarm Event Viewer. The following items are configurable:

• Enable - If this option is checked an alarm will be raised through the events subsystem if 
the Trending service stops recording for the specified time
(Poll period × Not Recording Count).

• Not Recording Count - Use this option to set the number of successive polls that must not 
detect the trending service is recording before an alarm is raised.

• Not Recording Hysteresis - Use this option to set the number of successive polls that must 
detect that the trending service is recording before an alarm is cleared.
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17 Data Communications Controller
The Data Communications Controller (DCC) sub-system consists of a number of services 
which are responsible for transmitting tank data to and from the PC.
The DCC sub-system is required for both standalone and client server configurations.
In a standalone environment all DCC services run on the same PC as the Tankvision 
Professional client modules.
In a client server environment all DCC services run on the PC dedicated as the database 
server.

The three main services are:
• DCC Host 
• DCC Slave 
• OPC Server 

The first two are automatically started when the PC is booted, whilst the OPC Server is 
started when an OPC client tries to connect to the Tankvision Professional system.
After the DCC has been configured, there is relatively little interaction between it and the 
users. However some maintenance operations may be required from time to time.

17.1 Stopping and Starting DCC
The DCC runs as a set of services, therefore when the PC is restarted they are automatically 
started. However there may be times when it is required to stop or restart the services.

To Stop the DCC services, proceed as follows:

Select All Programs → Endress+Hauser → DCC Monitor from the Windows start 
menu.
This will bring up the following screen:
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1.
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To stop the DCC services click on the Stop Services button.
When all Service Details have changed to Stopped the button will change to Start 
Services.

To start the DCC Host again simply click the Start Services button.
After a few moments all installed services should change to Running.

2.

3.
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17.2 Configuring a Host or Slave port
Host ports are responsible for collecting data from Datacons and gauges, calculating Tank 
Inventory, and processing command requests from the Tankvision Professional client.
Slave ports are responsible for sending data to other computer systems, such as the main 
DCS for the refinery, using protocols such as Modbus or Enraf.

To configure a port, proceed as follows:

Click on the Host Comms or Slave Comms tab in the DCC Config tool.
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A list of all physical COM ports (RS232/485/422 etc) will be displayed together with any 
logical Modem , Network, OPC and XML ports configured (they will have an offset of 40 for 
modems, 70 for network connections, 110 for OPC connections and 200 for XML ports i.e. 
COM41, 71, 101, 201 etc).

Select the COM port to configure and ensure the In Use box is ticked.
For modem , network, OPC or XML ports click on Add Modem Port, Add Network Port, 
Add OPC Port or Add XML Port to automatically add the port to the list.

Select the Protocol to be used on the port.

For XML ports this will be fixed as Generic XML.

The Slave Address only applies to Datacon protocol ports and should be set to the address 
of that device.
The Retries determines the number of consecutive failed polls before a communications 
failed alarm is generated for host ports.
The Background Scan Period determines the update times for certain gauge parameters, 
such as Density, Observed Temperature, Pressures, Vapour Temperature, Multi-Element 
Temperatures and Water Level. It is not used for slave ports.

1.

2.

3.
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For host ports the Connect section determines when to connect to the COM port or Modem 
and poll the gauges, usually this will be Always for direct serial ports and Scheduled for 
modem ports.
The Options section allows the operation of DCC Host to be modified as required. Current 
options supported include:

• Manual Levels set Programmable Alarms - by default a manual value will not trigger a 
programmable alarm, ticking this option will reverse this functionality.

• Servo/Stow set Programmable Alarms - by default when a gauge is moving due to a 
Stow/Unstow or servo command then programmable level alarms will be suppressed, 
ticking this option will reverse this functionality so that the current position of the sensing 
head will be used to trigger alarms.

For host ports, select the Redundancy option to that required, usually this will be left as 
No Redundancy.

Click on the Configure button next to the Hardware field to configure the 
communication parameters for the port.

A warning message may be displayed if a new Host port is added by selecting the 
In Use box and the number of licensed host interfaces has been exceeded:
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Adjust the parameters according to the explanation below.

Save the settings by clicking OK.

4.

5.

6.

7.



Data Communications Controller Tankvision Professional NXA85 - System Configuration

138 Endress+Hauser

17.3 Communication Parameter Configuration
Each Host or Slave port requires the Hardware configuring for the communication 
parameters. These parameters differ depending on the hardware, i.e. Physical COM ports, 
modems, Network connections, OPC or XML ports.

Click on the Configure button next to the Hardware field to configure the 
communication parameters for the port.

17.3.1 Serial ports
Serial ports require the Baud rate, Parity, Data Bits and Stop Bits configuring. Flow 
Control should always be set to None, except for SAAB protocol ports where it should be set 
to RTS.
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If the serial communications hardware produces an echo of sent characters (i.e. some RS485 
or 20mA current loop devices) then tick the Echo Expected field to tell the driver to handle 
the echoed characters.

17.3.2 Modem ports
Modem ports require the Modem and Phone Number configuring.
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The Modem should be selected from those installed in the operating system.

1.
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17.3.3 Network ports
Network ports require the Network Address, IP Port and the Delay Between Polls 
configuring.
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The Network Address is the address of the remote computer to connect to, and may be 
entered as a TCP/IP address or the PC name. The IP Port should be entered for the interface 
running on the remote system.
The Delay Between Polls is only required for host ports and should generally not be set 
below 100 ms.
For slave ports the Timeout for inactive connections setting is used to disconnect the 
remote system if no requests have occurred for that length of time. Do not set the value too 
low as it could affect communications. It should normally be set to 1 minute.
The Redundancy Settings are only active in a Redundant system. The Do Not Trigger 
Redundant Switch and Timeout Period are only available for Host ports and the Do Not 
Reply When Passive is only available for Slave ports.
Tick Do Not Trigger Redundant Switch to disable switchover for network ports.
Set the Timeout Period for the number of seconds to wait before triggering a switch over if 
no reply is received to polls from the Host port.
Tick Do Not Reply When Passive to prevent slave ports for the non active server in a 
redundant pair from replying to poll requests.

17.3.4 OPC ports
Require the Network Address of the host, the OPC Server and the Delay Between Polls 
configuring.
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The Network Address may be either a TCP/IP address or the PC name.
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The OPC server is selected by clicking the Browse ID button to get a list of all OPC servers on 
the specified Network Address and then selecting the OPC server required.
The Delay Between Polls should generally not be set below 100 ms.

17.3.5 XML ports
XML Ports require the Proxy Address and Proxy Port number of the proxy server 
configuring along with the Proxy Username and Proxy Password used to connect to the 
server. The Cache Refresh Interval can also be set but it is recommended to leave this at the 
default value of 75.
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17.4 Redundancy
The DCC Host service supports redundant communications to gauges using a pair of 
communication ports (Physical COM ports, modems or Network connections).

Any ports that are to be used as part of a redundant communications system should then 
have their Redundancy Settings field set to either of the following:
• Switch By Interface - where gauges will only switch to the Backup COM port if ALL gauges 

have failed on that interface.
• Switch By Gauge - where gauges will switch individually.

After the interfaces have been configured, the gauges may be configured with redundant 
operation. To do this, select the gauge in the Device Configuration screen in Tankvision 
Professional, then set the Local COM Port field to the desired primary interface port and the 
Backup COM Port field to the backup interface port.

BA00390GEN_0127
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17.5 Configuring scheduled connections
Host ports may be configured to connect at scheduled intervals, rather than always be 
connected. Scheduled connections are normally used on Modem ports, where the host port 
will connect to the remote site, poll for all the data and then automatically disconnect.

A host port may be set to one of the following connection types:
• Always - Interface will always try to be connected and polling the gauges.
• Manual - Interface will only connect and poll gauges if manually commanded by User.
• Scheduled by Hour - Interface will connect on the hours selected by the user.
• Scheduled by Interval - Interface will connect periodically.

For scheduled connections the times to connect must be configured by clicking on the 
Configure button next to the Connect field.
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17.6 Configuring protocols
Most of the Slave protocols (Modbus , Enraf  etc ) and some Host protocols (ModbusTG) 
require extra configuration that is specific to the protocol.
To configure any protocol specific data, proceed as follows:

Select either the DCCHost Configuration or the DCC Slave Configuration item from the 
Configuration menu.
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Refer to the appropriate DCC configuration manual for details on configuring the protocol 
data.

1.
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17.7 Communications Monitor
To view the DCC Host Comms Monitor, proceed as follows:

Select All Programs → Endress+Hauser → DCC Monitor from the Windows start 
menu.
This will bring up the following screen:
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The DC Host module allows the user to view the data communications that occurs between 
the PC and any connected devices such as Datacons or directly connected gauges.
From the drop down list select the COM port you chose for communication, e.g. Com 3. A list 
of gauges being polled on that COM port will be displayed in the box below.
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The communications statistics are displayed in the Statistics section. These are useful for 
indicating communications problems. 
To view the data for a gauge, click on that item in the list.

1.
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The parameters returned from the gauge, such as Level, Temperature etc. will be displayed 
on the left hand side of the screen.
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18 Device Command Scheduler
The Device Command Scheduler is a Windows service that can be configured to send device 
commands at a specific time of day on a recurring basis.
The Device Commands can be sent to a Single Tank, all Tanks, or a group of tanks generally 
specified by Gauge Type or Tank Group.
Care should be exercised when scheduling device commands, particularly those that affect a 
gauges primary measuring capability, as the tank may be involved in some sort of critical 
operation such as receiving product from a ship or similar.

18.1 Launching the Device Command Scheduler
The windows service part of the scheduler, which sends the commands at the scheduled 
time, automatically starts up when Windows boots. The service can be monitored, as with all 
Windows services via the control panel, or using the application Service Manager, which is 
present as an icon in the system tray.

18.2 Configuring Scheduled Commands
The schedule by which the commands are executed is configured from the Command 
Scheduler GUI.
To configure scheduled commands, proceed as follows:

Right click on the Service Manager icon in the Windows system tray:
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Select Device Command Service → Device Command Config.
This will bring up the configuration application, which you can use to view and edit the 
scheduled commands.
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Select a scheduled entry from the list on the left of the window or create a new entry by 
clicking the New button.

1.

2.

3.
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You can also delete an entry from the database by selecting it from the list and clicking 
the Delete button.

Adjust the parameters according to the explanations below (→ ä 147).

Click Save to commit the changes to the database, or Cancel to discard them.

Scheduled entries are listed on the left of the window, selecting one of these entries will 
display the details of the entry in the controls on the right.

18.2.1 Scheduled Commands Parameters

Destination
Denotes the way the gauges can be selected for scheduling, either by a specific Tank ID, or 
collectively by Product Group Name, or by Product or by Gauge Type.

Gauge Duty
Where tanks are fitted with more than one gauge, you can specify which gauge on the tank 
is to perform the command.

Command
Sets the command to be executed by the gauge or gauges.

Custom Command
Enables you to configure a custom command.

Schedule
A scheduled command can be configured to send a series of commands between two 
specified times and a specified frequency. For example to send a command every hour 
between the hours of 01:00 and 04:00 you would set the start time as 01:00, the stop time 
04:00 and the interval as 01:00.

When you make changes to the schedule's detail, click Save to commit the changes to 
the database, or Cancel to discard them.
Clicking New will clear the currently selected entry's details, allowing you configure a 
new one. Clicking Save commits the entry to the database.
Delete will remove the currently selected entry from the database.

4.

5.
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19 Report Scheduler
The report scheduler facilitates the printing and exporting of reports and report documents 
in various formats at defined moments in time.

The report scheduler consists of 2 independent components:
• A background Report Scheduler Windows Service which executes the reports at the 

appropriate time(s).
• The Report Scheduler Configuration tool, used for configuring the reports.

The report configuration data is held in the file ReportSchedulerConfig.xml located in the 
same directory as the ReportSchedulerService.exe service executable.
This file is used by both of the above components. The configuration tool is used to edit the 
contents of the file for the desired user configuration. The service then loads this file to 
determine its actions.

19.1 Report Scheduler Service
The Report Scheduler service runs automatically as a Windows service, executing all 
scheduled reports at the appropriate times. It will run in the background and has no user 
interface.
The service will start automatically whenever the computer is rebooted and should therefore 
always be running.
The status of the service can be viewed by right clicking on the Tank Gauging Service 
Manager icon in the system tray and selecting the Report Scheduler Service item from the 
pop-up menu.
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The service may also be started or stopped using this menu.

19.2 Spooling of Scheduled Reports
Reports that are printed by the service are spooled to a directory where they are stored for a 
period of seven days before being deleted. This enables an administrator to obtain any time 
critical reports that have failed to print for any reason.
The location of the spool directory can be specified by the user by using the configuration 
tool to change the Spool Directory settings of the Area component.
Spooling does not occur if the reports are printed directly from the configuration tool.
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19.3 Report Scheduler Configuration
The Report Scheduler Configuration tool allows the user to configure the reports and report 
documents for a system.
To configure the report scheduler, proceed as follows:

Right click on the Tank Gauging Service Manager icon in the system tray.

Select the Report Scheduler Config item from the Report Scheduler Service menu:
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The following window opens:
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From the tree on the left select the component you are going to edit.
The tree view control on the left hand side of the configuration tool represents the 
components which exist on the system. 

 The following types of components can appear in the tree view:
• Areas
• Batches
• Reports
• Report Documents
• Triggers

The grid view adjacent to the tree view represents the settings for each of these components.
For a description of these types of components refer to the sections below.

Enter the required values into the grid view on the right.

1.

2.

3.
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Click Apply to confirm your changes or Cancel to discard them.

If all the necessary changes have been made, click OK to close the window.

Any changes which are made to the report scheduler configuration will only be written 
to the ReportSchedulerConfig.xml when the user hits OK or Apply. If the user hits 
Cancel all changes to the configuration will be lost.

19.3.1 Area Component

Icon_Area_Component

The reporting system is represented by the root component of the tree, called an Area.

Renaming an Area component
The Area component can be renamed to reflect the name of the site and/or system. To do 
so, right click on the Area component and select Rename.

The Transaction log
The Area component also defines settings which determine the location of the transaction 
log. The transaction log stores information about the execution of the reports that the 
system processes and any consequent abnormal operating conditions. Right click on the 
Area component and select Transaction Log to view the log using Wordpad.

The System Reports directory
Also defined by the Area component is the System Reports directory. This is the directory 
which contains the predefined reports associated with the tank automation system. Both the 
Transaction Log directory and the System Report directory are set to sensible defaults upon 
installation, but can be easily changed if necessary.

4.

5.
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19.3.2 Batch Component

Icon_Batch_Component

Report, Report Document and Trigger components are contained within Batches. An Area 
can contain one or more Batches. 
A Batch defines various settings which describe the printing/export behaviour of the Report 
and Report Document components that it contains.

Adding Batches
In order to add a Report or Trigger to the system, we must first add a Batch. Right click on 
the Area node and select Add Batch from the menu. This adds a Batch to the Area.

Renaming/deleting Batches
The Batch can be renamed if required by right clicking on the Batch and selecting Rename 
Batch from the menu. A batch can be deleted from the Area in a similar way.

Locking and Unlocking Batches
Batches can be locked to prevent unauthorized users from deleting or modifying them. In 
order for a user to be able to lock or unlock a batch that user must be granted 'Full' Report 
Scheduler privileges. Users with 'Modify' privileges will be able to create, delete and maintain 
unlocked batches, but they won't be able to remove or place a lock on a batch.
In order to lock a batch, right-click on an unlocked batch and choose Lock Batch from the 
context menu, the unlocking process is similar except you choose Unlock Batch instead. A 
locked batch can't be altered - it must be unlocked in order to be amended.
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Locked batches can be identified by the lock icon superimposed over the top of the filing 
cabinet icon.
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Batch Print Settings
Click on Batch Print Settings to change the following parameters:
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• Default Printer - The default printer for report printing. Select from all installed printers 
in the drop down list. The list reflects the users installed printers only. 
[see: Start → Settings → Printers]]

• Secondary Printer - The secondary printer is used for printing if the default printer is 
unavailable.

In both cases the printer must be a real printer, not a print to file device as the service 
does not interact with the console.

1.
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Batch Export Settings
Click on Batch Export Settings to change the following parameters:

BA00390GEN_0243

• Export Type – The format of the exported report. Select from all available formats in the 
drop down list including .rpt, .xls, .pdf, .rtf and .doc.

• Export to disk – Path to folder which will contain the exported report. Blank entry disables 
disk export.

• Export to email – Semicolon separated list of email addresses to which the report will be 
sent. Blank entry disables email export. (Users require an SMTP mail server to use this 
feature; the server itself is specified as an Area setting.)

• Sender E-Mail Address – The address that will appear in the ’From’ field of received E-
mails.

• Subject – Enter the text that will appear in the ’Subject’ field of received E-mails.

1.
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Batch FTP Export Settings
Click on Batch FTP Export Settings to change the following parameters:
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• Ftp Server Name – The full name used to identify the ftp server. Blank entry disables ftp 
export.

• Ftp Username – Username used to logon to the ftp server.
• Ftp Password – Password associated with ftp username.
• Ftp Path – The path to the drop directory on the Ftp server.

1.
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19.3.3 Report Component

Icon_Report_Comment

A Batch can contain one or more Report components each of which represents a Crystal 
Reports format report file. 
To add a Report to a Batch, right click the Batch, select Add Report and select a .rpt file using 
the 'Open File' dialog box displayed. 
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To remove a Report from a Batch, right click on it and select Delete Report.

A Report defines the following settings which describes the Reports individual behaviour 
independent of it's parent Batch settings:

General Settings
• Print Enabled

Printing enabled for this report.
• Export Enabled

Export enabled for this report.
• Date Stamp Export

If True, add the date to the filename for the exported file.
• Time Stamp Export

If True, add the time to the filename for the exported report.

Database Settings
• Data Source Name

Specify the ODBC data source name.
• Database Name

The name of the database used to generate the report.
• User ID

The user name used to logon to the database. The default is 'sa'.
• Password
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The password associated with the User ID. The default is blank.

Parameter Settings
This section is auto-generated from the report itself. If the report gives the user the option 
of specifying parameters they can be entered here. The default values for each field are 
shown in a combo box if any are specified.
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19.3.4 Report Document Component

Icon_Word

Icon_Excel

A Batch can contain one or more Report Document components. Each Report Document 
component represents a Word document or an Excel Workbook which conveys report data.
Report and Report Document components can happily co-exist within the same Batch.
To add a Report Document to a Batch, right click on the Batch, select Add Report Document 
and select a .doc or .xls file using the Open File dialog box displayed. To remove a Report 
Document from a Batch, right click on it and select Delete Report.

In order to use Report Document components within the Report Scheduler, Microsoft 
Office 2003 or later must be installed.
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19.3.5 Trigger Component

Icon_Trigger

A batch can also contain one or more Triggers. A Trigger is a component which specifies 
when a Batch will run, and hence when all of its Report modules will run. Right mouse click 
on the Batch component to see the trigger options as shown below.
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There are 6 types of Triggers:

1. Interval Trigger
A trigger which is fired every time interval, defined in hours and minutes. A 
synchronization time may also be defined, from which all interval timings will be based.

2. Hourly Trigger
A trigger which is fired at a specified number of minutes past every hour.

3. Daily Trigger
A trigger which is fired at a specified hour every day.

4. Weekly Trigger
A trigger which is fired on a specified day of the week, at a specified hour.

5. Monthly Trigger
A trigger which is fired on a specified day of the month, at a specified hour.

6. Run Once Trigger
A trigger which is fired once only at a specified time.

By adding Triggers to Batches it is easy to build up complex scheduling. For example, if it is 
required that a Batch is run three times a week, add 3 Weekly Triggers to a Batch, specifying 
a different firing day for each.

To add a Trigger to a Batch, right click on the Batch, select Add Trigger and select the 
trigger type from the submenu.
To remove a Trigger from a Batch, right click on it and select Delete Trigger.
You can also specify a period of time over which a trigger will be active on the Trigger 
Period Settings page.
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19.3.6 View, Print and Export Reports
It is possible to print, export or view a Report or Report Document directly from the GUI 
rather than relying upon Triggers and the service component.

Right click on the relevant component and select Print, Export or View from the menu.
The configuration is automatically saved should any of these commands be used.
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Any changes which are made to the report scheduler configuration will only be written 
to the ReportSchedulerConfig.xml when the user hits OK or Apply. If the user hits 
Cancel all changes to the configuration will be lost.

1.
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20 Messaging

20.1 Message Service
The messaging service is used to queue and distribute messages asynchronously.  Messages 
can be sent to:

• E-mail clients (SMTP mail server required).
• Mobile telephones in the form of SMS messages (GSM modem required).
• Telephones (voice modem required).
• Site Radios (specialist hardware required).

The messaging service configuration is accessed from the application Service Manager icon 
in the Windows system tray.
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Click right on this icon.

Select Messaging Service → Messaging Service Config.

This will bring up the configuration application, which you can use to view and edit the 
messaging configuration.
This application contains the following pages:
• General
• E-Mail
• SMS (if the SMS Messaging option has been licensed)
• Telephone (if the Telephone Messaging option has been licensed)
• Radio (if the Radio Messaging option has been licensed)

1.

2.
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20.1.1 General
The general page allows configuration of settings relating to the messaging service as a 
whole:

BA00390GEN_0246

TCP Port
The TCP port which is used to accept messages from client applications. This must match the 
TCP port configured in the messaging client configuration file.

Interval
The interval in milliseconds at which the service will check for incoming messages.

Logging
The level of logging required. This is used for diagnostic purposes if there are problems with 
the messaging service. Generally it should be set to Off.

Log Path
The path to the log file.

The current log file can be viewed by clicking on the View Log button, or deleted by clicking 
on the Delete Log button.
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20.1.2 E-Mail Configuration
The E-Mail page allows configuration of settings relating to sending e-mails:
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SMTP Server
The SMTP server to be used to send e-mails from the messaging service. (User name and 
Password valid for the domain are required for external emails.)

SMTP Port
The port used by the messaging service to connect to the SMTP server.

Send Attempts
The maximum number of times a message should be sent to the SMTP server if it fails for 
any reason on a preceding attempt.

Send Retry Delay
The interval to wait before attempting to resend a message to the SMTP server following a 
failure.

Logging
The level of logging required. This is used for diagnostic purposes if there are problems with 
the e-mail part of the messaging service. Generally it should be set to Off.
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20.1.3 SMS Configuration
The SMS page allows configuration of settings relating to sending SMS messages. It will only 
be present if the SMS Messaging option has been licensed:
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Serial Port
The serial port to which the GSM modem to be used to send SMS messages is attached.

Send Attempts
The maximum number of times to attempt to send a message via SMS.

Retry Interval
The interval to wait before attempting to resend a message following a failure.

Send Order
Indicates whether messages are to be sent in priority order, or in the order in which they 
were received from clients.

Logging
The level of logging required. This is used for diagnostic purposes if there are problems with 
the SMS part of the messaging service. Generally it should be set to Off.
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20.1.4 Telephone Configuration
The Telephone page allows configuration of settings relating to sending voice messages to a 
telephone. It will be present only if the Telephone Messaging option has been licensed.
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Serial Port
The serial port to which the modem used to send voice messages is attached. The modem 
must be a voice modem. To check if the modem is compatible with the messaging service, 
open HyperTerminal and connect to the modem as a serial device. Then type AT+FCLASS=?. 
The response should be in the form 0,1,8,80 (followed by OK). This list of supported classes 
must contain 8 for the modem to be used to transmit voice messages.

Send Attempts
The maximum number of times to attempt to transmit the message to a telephone.

Retry Interval
The interval to wait before attempting to resend a message after a failure.

Send Order/Then
The order in which messages are to be transmitted.

Outside Line
Some locations require a number to be dialed to access an outside line. If this is the case, 
enter the number in this field.

Logging
The level of logging required. This is used for diagnostic purposes if there are problems with 
the telephone part of the messaging service. Generally it should be set to Off.
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20.1.5 Radio Configuration
The Radio page allows configuration of settings relating to broadcasting messages over a 
radio network. It will be present only if the Radio Messaging option has been licensed.
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Adding a radio network
To add a new radio network click the Add button. The settings screen is displayed 
(→ ä 167).

Removing a radio network
To delete an existing radio network select it from the list and the click the Remove button.

Editing a radio network
To edit an existing radio network select it from the list and then click the Properties button. 
The settings screen is displayed (→ ä 167).

Testing a radio network
To broadcast a test message, proceed as follows:

Click the Test button.
The following screen will be displayed:
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1.
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Configure the test message to be broadcast (for more details → ä 171).

Click the Test button.

If the radio network has been configured correctly the message should be broadcast over the 
site radio. The status of the relay board inputs and outputs should be indicated correctly 
during the broadcast. The status of the inputs and outputs can be used to determine the 
configuration issues if the message fails to broadcast.

2.

3.
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20.1.6 Radio Settings

Radio Settings - Radio
The Radio page allows the basic configuration details for a site radio to be set up.
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• Name – The name used to identify this radio configuration.
• Playback Device – The playback device on the PC which will be used to generated the 

audio to be broadcast over the radio. It is strongly recommended that this is not the default 
playback device for the PC, since that might lead to other audio output from the PC being 
inadvertently broadcast over the radio.

• Radio Type – There are three possible types of radio configuration – simple, standard or 
trunking. The difference lies in the way that the COR (Carrier On Relay) input is handled. 
For simple radio systems the COR input is ignored and the message is broadcast 
immediately, ignoring any other transmissions in progress.

• Relay Board – The index of the ArcCom relay board which is connected to the ROB (Radio 
Output Board) and optionally an alarm panel and/or manual reset switch.

• Output Channel – The index of the relay on the ArcCom relay board which is connected 
to the PTT terminal of the radio output board.

• COR Channel – Not applicable for simple radios.  The index of the input on the ArcCom 
relay board which is connected to the COR terminal of the radio output board.

• Radio channel is busy when COR is High/Low – Not applicable for simple radios. 
Indicates whether the radio channel is busy when the COR input is high or low. This may 
vary from base station to base station.

• COR Inactive Interval – Not applicable for simple radios. The number of seconds the COR 
input needs to be inactive before an attempt is made to broadcast a message.

• Wait Interval – Trunking radios only. The number of seconds to wait for the COR input to 
become inactive after PTT.

• Wait Retry Interval – Trunking radios only.  The number of seconds to wait before setting 
the PTT following the COR input failing to become inactive during a transmission attempt.
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Radio Settings - Messages
The Messages page allows message configuration details to be set up.
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• Default Repeat – The number of times a message is to be repeated by default unless it is 
specifically overridden.

• Default Repeat Interval – The length of time before a message is to be repeated.
• Gap – The length of time to be left before broadcasting the next message.
• Key Up Delay – The length of time between setting PTT and beginning to output the audio
• Key Down Delay – The length of time between completing the audio output and unsetting 

PTT.
• Prefix – A standard message to be prefixed to all broadcast messages. This can be used to 

add a standard call sign for example. To edit this message click the  button to the right 
of the field. See section on Configuring Audio Messages for more details (→ ä 171).

• Suffix – A standard message to be suffixed to all broadcast messages. This can be used to 
add a standard sign-off for example. To edit this message click the  button to the right 
of the field. See section on Configuring Audio Messages for more details (→ ä 171).

• Manual Clear Channel – The index of the input on the ArcCom relay board to which the 
manual reset switch is connected. If no manual reset switch is in use, this should be set to 
0.
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Radio Settings - Communications
The Communications page allows configuration of the comms failure functionality.
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• Check for Comms Failure – Indicates whether the messaging service is to check whether 
communications with calling applications is interrupted.

• Watchdog Interval – The interval defining what constitutes a communications failure.
• Message – The message to be broadcast when a communications failure is identified. To 

edit this message click the  button on the right side of the field. See section on 
Configuring Audio Messages for more details (→ ä 171).

• Repeat Interval – The interval at which the communications failure message is to be 
broadcast until communications with client applications is restored.



Messaging Tankvision Professional NXA85 - System Configuration

170 Endress+Hauser

Radio Settings - Health Check
The Health Check page allows configuration of the health check functionality.
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Health Check Channel – The index of the relay on the ArcCom relay board which is 
connected to the health check terminal on the radio output board. If no health checking is to 
be performed, this should be set to 0.

Output Channel – The index of the relay on the ArcCom relay board which is connected to 
an alarm indicator (such as an alarm panel). If no external alarm is being used, this should 
be set to 0.

Health check output channel is Active/Inactive when power is off – This field allows 
configuration of the default state of the external alarm indicator. This means that the system 
can be configured to display an external alarm if the PC is shut down.

Radio Test – This field allows a periodic test to be carried out to ensure that the audio output 
from the PC is reaching the radio output board. This can be one of the following values:

• Off - No test performed.
• On - The test message is broadcast over the radio if no message has been broadcast in the 

time defined in the Radio Test Interval field.
• On (Timed) - The test message is broadcast over the radio at intervals defined by the 

Radio Test Sync Time and Radio Test Interval fields irrespective of when the last 
message was broadcast over the radio.

• Silent - The audio message is to be transmitted to the radio output board if no message 
has been broadcast in the time defined in the Radio Test Interval field.However, PTT is 
not set so the message is not actually broadcast over the radio.

• Silent (Timed) - The audio message is to be transmitted to the radio output board at 
intervals defined by the Radio Test Sync Time and Radio Test Interval fields irrespective 
of when the last message was broadcast over the radio. However, PTT is not set so the 
message is not actually broadcast over the radio.

Message – The message to be broadcast. To edit this message click the  button on the 
right side of the field. See section on Configuring Audio Messages for more details 
(→ ä 171).
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20.2 Configuring Audio Messages
Configuring Audio Messages is a relatively simple process. However, in the interests of 
integrity and flexibility fields containing audio messages cannot be edited directly.
Throughout the system where a message field is used, it is read-only and has a  button 
next to it.

To edit the message click on the  button.
This will bring up a separate screen allowing editing of the message. Although these 
screens may differ in detail they will always contain the following fields:
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Adding a message element
To add a new message element click the Add button.

• Clicking on the arrow on the button will display a dropdown menu allowing selection of 
the element type:
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• Clicking on the main part of the button automatically selects the previous message 
element type (defaulting to Audio if no previous selection has been made).

A configuration screen for the message element will be displayed (→ ä 172, → ä 174).

Click the OK button on the configuration screen.
The message element is added to the message.

Editing a message element
To edit a message element, proceed as follows:

Select the message element in the list.

Click the Edit button. 
The relevant configuration screen for the message element will be displayed (→ ä 172, 
→ ä 174).

Click the OK button on the configuration screen.
The message element is updated.

1.

1.

2.

1.

2.

3.
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Removing a message element
To remove a message element, proceed as follows:

Select the message element in the list.

Click the Remove button.

Moving a message element up or down
To move a message element to earlier in the message, proceed as follows:

Select the message element in the list.

Click the Move Up button until the required position is reached.

To move a message element to later in the message, proceed as follows:

Select the message element in the list.

Click the Move Down button until the required position is reached.

20.2.1 Audio Element
The audio element simply plays an audio file as part of the message.

Select the audio file on the audio configuration screen.
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The audio files available to the messaging service are stored in a directory called Messaging 
Media which can be found under the directory that the messaging service is installed in.

Click the OK button.

20.2.2 Break Element
The Break element allows the insertion of a break between other message elements. The 
break can either be a pre-defined length, or explicitly specified.

1.

2.

1.

2.

1.

2.

1.

2.
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To explicitly specify the length of a break, proceed as follows:

Select Timed from the dropdown list of break types.

Enter the duration of the break in milliseconds in the Duration field.
1.

2.
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20.2.3 Text Element
The Text element allows the use of free format text which will be synthesized using the text 
to speech functionality of Windows.
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21 Web Server
The install package now includes a web server. If you have 1 or more concurrent web clients 
available in your license then you can connect to your tank gauging server using a browser. 
You do not need to install IIS or go through the procedure for creating virtual directories.

21.1 Server
The only indication within the main product is the presence of the Janus Web Server in the 
list of services in Service Manager and the ability to configure the web and data services 
through that option.

Web server uses the security manager to control access to its features.
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The web server permits the users to view tank gauging data in a number of displays 
mimicking the appearance of the main tank gauging applications and to control certain 
aspects remotely such as gauge commands and manual data.

Security on the web interface is configured in the same way as the main applications, the 
settings being shared between the main application and the web interface. For instance if a 
user is denied access to manual data in the main application, the same will be true of the web 
interface.

21.2 Web Clients
The clients for the web server need to have Silverlight 4 installed to be able to display the 
tank gauging information, which means that although the users have a fairly free hand in 
their choice of browser they must use one of the operating systems supported by Silverlight, 
which at the time of writing is Windows and Mac OS X.

To install the Web Client, navigate to the appropriate URL (e.g. "http://tanks" – where "tanks" 
is the name of the Tank Gauging server PC).
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In addition to the tank gauging user interface, there is also an event viewer for the web 
interface. If your machine is called "tanks", then if you browse to "http://tanks/alarms" you 
will have the option of installing a web alarm event viewer on your client machine.
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This alarm event viewer enables the user to receive notification of alarm situations on site 
in real time and even acknowledge them.
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